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Technical Support

Symantec Technical Support maintains support centers globally. Technical Support’s 
primary role is to respond to specific queries about product features and functionality. 
The Technical Support group also creates content for our online Knowledge Base. The 
Technical Support group works collaboratively with the other functional areas within 
Symantec to answer your questions in a timely fashion. For example, the Technical 
Support group works with Product Engineering and Symantec Security Response to 
provide alerting services and virus definition updates.

Symantec’s maintenance offerings include the following:

A range of support options that give you the flexibility to select the right amount of 
service for any size organization

Telephone and Web-based support that provides rapid response and up-to-the-
minute information

Upgrade assurance that delivers automatic software upgrade protection

Advanced features, including Account Management Services

For information about Symantec’s Maintenance Programs, you can visit our Web site at 
the following URL:

www.symantec.com/techsupp/

Contacting Technical Support
Customers with a current maintenance agreement may access Technical Support 
information at the following URL:

www.symantec.com/techsupp/

Before contacting Technical Support, make sure you have satisfied the system 
requirements that are listed in your product documentation. Also, you should be at the 
computer on which the problem occurred, in case it is necessary to replicate the 
problem.

When you contact Technical Support, please have the following information available:

Product release level

Hardware information

Available memory, disk space, and NIC information

Operating system

Version and patch level

Network topology

Router, gateway, and IP address information

Problem description:

Error messages and log files

Troubleshooting that was performed before contacting Symantec

Recent software configuration changes and network changes
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Licensing and registration

If your Symantec product requires registration or a license key, access our technical 
support Web page at the following URL:

www.symantec.com/techsupp/

Customer service
Customer service information is available at the following URL:

www.symantec.com/techsupp/

Customer Service is available to assist with the following types of issues:

Questions regarding product licensing or serialization

Product registration updates, such as address or name changes

General product information (features, language availability, local dealers)

Latest information about product updates and upgrades

Information about upgrade assurance and maintenance contracts

Information about the Symantec Buying Programs

Advice about Symantec’s technical support options

Nontechnical presales questions

Issues that are related to CD-ROMs or manuals

Maintenance agreement resources
If you want to contact Symantec regarding an existing maintenance agreement, please 
contact the maintenance agreement administration team for your region as follows:

Additional enterprise services
Symantec offers a comprehensive set of services that allow you to maximize your 
investment in Symantec products and to develop your knowledge, expertise, and global 
insight, which enable you to manage your business risks proactively.

Enterprise services that are available include the following:

Asia-Pacific and Japan customercare_apac@symantec.com

Europe, Middle-East, and Africa semea@symantec.com

North America and Latin America supportsolutions@symantec.com

Symantec Early 
Warning Solutions

These solutions provide early warning of cyber attacks, 
comprehensive threat analysis, and countermeasures to prevent 
attacks before they occur.

Managed Security 
Services

These services remove the burden of managing and monitoring 
security devices and events, ensuring rapid response to real 
threats.
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To access more information about Enterprise services, please visit our Web site at the 
following URL:

www.symantec.com

Select your country or language from the site index.

Consulting 
Services

Symantec Consulting Services provide on-site technical 
expertise from Symantec and its trusted partners. Symantec 
Consulting Services offer a variety of prepackaged and 
customizable options that include assessment, design, 
implementation, monitoring, and management capabilities. Each 
is focused on establishing and maintaining the integrity and 
availability of your IT resources.

Educational 
Services

Educational Services provide a full array of technical training, 
security education, security certification, and awareness 
communication programs.
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Chapter 1
Planning the Installation of Wise Package Studio

This chapter includes the following topics:

System Requirements on page 8

Before You Install Wise Package Studio on page 12

Choosing the Location for the Share Point Directory on page 13

Configuration Best Practices on page 14

Authentication Best Practices on page 21

Product Documentation on page 22

System Requirements
This section describes the minimum system requirements for running Wise Package 
Studio.

Restrictions

Wise Package Studio cannot be installed on any computer that contains any edition or 
version of the following:

Wise for Visual Studio .NET

Wise for Windows Installer

Wise Installation Studio

Wise Installation Express

Supported Operating Systems for Installations That You Create

Installations that you create in Wise Package Studio can run on any operating system 
that Wise Package Studio supports.

See:

Requirements for Wise Package Studio Server on page 9
Requirements for Wise Package Studio Client on page 9
Requirements for Wise Package Studio Web Applications on page 10
Requirements for .NET Framework on page 12
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Requirements for Wise Package Studio Server

Wise Package Studio Professional or Enterprise Management Server

Requirements for Wise Package Studio Client

Computer/processor Pentium IV-class processor

Minimum: 1 GHz
Recommended: 2 GHz
Optimal: 4 GHz

Operating system Minimum: Windows Server 2000 
Recommended: Windows Server 2003 or 
Windows Server 2008
Also supported: Windows XP Professional 
SP2 and SP3, Windows Vista, Windows 7

Note
SetupCapture cannot be run on 
unsupported operating systems. To 
capture on those operating systems, use 
Wise Web Capture, which is described in 
the Wise Package Studio Help.

Microsoft Internet 
Explorer

Minimum: 6.0
Recommended: 7.0 or 8.0

RAM Minimum: 512 MB
Recommended: 2 GB
Optimal: 4 GB

Database Microsoft SQL Server (English version 
only)

Required: SQL Server 2005, SQL Server 
2005 Express, or SQL Server 2008

If you are upgrading from a previous 
version of Wise Package Studio that used 
Access or MSDE databases, the Wise 
Repository Manager will upgrade the 
databases.

Computer/processor PC with a Pentium III-class processor

Minimum: 800 MHz
Recommended: 1 GHz
Optimal: 2 GHz
Wise Package Studio Getting Started Guide 9
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Requirements for Wise Package Studio Web Applications

Not available in Standard Edition

Availability of the Web applications depends on the module or edition of Wise Package 
Studio that you install. 

System Requirements

Operating system Minimum: Windows 2000 SP4
Recommended: Windows XP Professional 
SP2 or later
Also supported: Windows Vista, Windows 
2003, Windows 2008, Windows 7

Note
SetupCapture cannot be run on 
unsupported operating systems. To 
capture on those operating systems, use 
Wise Web Capture, which is described in 
the Wise Package Studio Help.

Microsoft Internet 
Explorer

Minimum: 6.0
Recommended: 7.0 or 8.0

RAM Minimum: 256 MB
Recommended: 512 MB
Optimal: 1 GB

Web Application Requirement

Management Reports Enterprise Management Server 
module

Preflight Data Collector and 
Preflight Analysis

Quality Assurance module

Wise Web Capture Professional Edition

Computer/processor PC with a Pentium III-class processor

Minimum: 800 MHz
Recommended: 1 GHz
Optimal: 2 GHz

Operating system As required by Microsoft Internet 
Information Server
Wise Package Studio Getting Started Guide 10
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Configuring a 64-bit computer for the Wise Package Studio Web 
Applications

To run the Wise Package Studio Web Applications on a 64-bit computer, you must 
configure IIS to be 32-bit enabled. You must also verify that ASP.NET 2.0 (32-bit) is 
registered with IIS.

To configure a 64-bit computer for the Wise Package Studio Web 
Applications

1. To configure IIS to be 32-bit enabled, run the following command line:

CSCRIPT %SYSTEMDRIVE%\Inetpub\AdminScripts\adsutil.vbs SET w3SVC/
AppPools/Enable32bitAppOnWin64 1

2. To ensure that the changes in the previous step take effect, stop and start the 
W3SVC service.

You can use the following command lines to stop and start the service:

NET STOP W3SVC /y

NET START W3SVC

3. To ensure that ASP.NET 2.0 (32-bit) is registered with IIS, run the following 
command line:

C:\WINDOWS\microsoft.net\Framework\v2.0.50727\aspnet_regiis.exe -i

Microsoft Internet 
Information Server 
(IIS)

Minimum: 5.0
Recommended: 5.1 to 7.5
On a computer running a 64-bit operating 
system, you must configure IIS so that it 
is 32-bit enabled. ASP.NET 2.0 (32-bit) 
must also be registered with IIS.
See Configuring a 64-bit computer for the 
Wise Package Studio Web Applications on 
page 11.

Microsoft Internet 
Explorer

Minimum: 6.0
Recommended: 7.0 or 8.0

RAM Minimum: 256 MB
Recommended: 512 MB
Optimal: 1 GB

Database Microsoft SQL Server (English version 
only)

Required: SQL Server 2005, SQL Server 
2005 Express, or SQL Server 2008

.NET Framework (Wise 
Web Capture only)

2.0 must be installed on the server. Later 
versions may be installed also, but Wise 
Web Capture works with version 2.0 only.

ASP Must be installed and enabled

ASP.NET (Wise Web 
Capture only)

Must be installed and enabled

ISAPI extensions Must be enabled
Wise Package Studio Getting Started Guide 11
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Requirements for .NET Framework
The .NET Framework is required for advanced .NET support in Windows Installer Editor. 
The .NET Framework requires Microsoft® Internet Explorer 5.01 or later and one of the 
operating systems supported by Wise Package Studio.

Version 1.1 of the .NET Framework is required by the Wise Web Capture tool. Later 
versions may be installed also, but Wise Web Capture works with version 1.1 only.

Before You Install Wise Package Studio
You might need to gather information, from a team leader, system administrator, 
database administrator, or other team members, that will enable you to install Wise 
Package Studio correctly for your environment.

Review the configuration best practices to determine the best configuration for your 
environment.

See Configuration Best Practices on page 14.

If you are upgrading from a previous version of Wise Package Studio, back up the 
existing share point directory and Wise Package Studio databases.

Have serial numbers available during installation. If this is an upgrade, you also 
need the serial number of the previous version. To find this, open the previous 
version of Wise Package Studio and select Help menu > About.

(Professional Edition only) If you plan to use a hidden share for the destination 
directory, create the directory and designate it as hidden before you install Wise 
Package Studio. Although this configuration is allowed, we do not recommend it.

Find out what share point directory to use. In a multi-user environment, the share 
point directory must be on a shared network drive. All users in a workgroup must 
specify the same share point directory during installation. This lets all users access 
the same packages and data.

See Choosing the Location for the Share Point Directory on page 13.

If you have been using a previous version of Wise Package Studio, you can use your 
existing share point, but data will be updated to a new format.

(Professional Edition only) Obtain the following information about the databases you 
are using for Wise Package Studio:

The name of the server that contains the database and the authentication 
method (NT or SQL Server) that the database uses.

Whether the database has been created or whether you need to create it during 
installation. If it does not exist or needs to be upgraded, you need database 
administrator privileges to create or upgrade it.

So that you can create databases, either your currently logged on user profile 
must have database administrator privileges on the database server, or you 
must have the SQL user name and password of a database administrator 
available.

If you plan to use SQL Server authentication, you will need to create users 
during installation. These users will have access to the database you create. You 
need to know what user IDs to create.
Wise Package Studio Getting Started Guide 12
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If you plan to use SQL Server authentication, you must configure the target 
database server to support SQL authentication before you set up any Wise 
Package Studio databases.

If you are performing a client installation, obtain the following information about the 
server installation that the client will connect to.

The name and location of the share point directory that was configured during 
the server installation.

(Network Client installations.) The location of the Wise Package Studio directory 
that was specified during the server installation.

For a list of the options for installing Wise Package Studio, see Installation Options on 
page 24.

Choosing the Location for the Share Point Directory

Not available in Standard Edition.
The Standard Edition does not use a share point directory.

The recommended location of the share point directory depends on your environment 
and the edition of Wise Package Studio you have purchased.

Where to Locate the Share Point Directory

The share point directory must reside on the same computer as the Wise Package Studio 
application files. Versions of Wise Package Studio earlier than 6.0 did not enforce this. If 
you are upgrading to 6.0 or later, and your share point directory is not on the same 
computer as Wise Package Studio, you must perform the upgrade so that Wise Package 
Studio is on the same computer as the share point directory.

See Upgrading an Unsupported Wise Package Studio Configuration on page 20.

When the share point directory is on a shared network drive, all users in a workgroup 
must specify the same share point directory during installation. This lets all users access 
the same packages and data.

How is the Share Point Directory Created?

During the initial Wise Package Studio server installation, the share point directory 
is created and shared by the Wise Repository Manager.

Environment Share Point Location

Single user installing 
Professional Edition

Local or network directory.

Team, sharing project 
files, and installing 
Professional Edition or 
Enterprise Management 
Server

Shared network directory accessible to 
team members.

In a large enterprise with multiple teams, 
each team might use a different share 
point directory and Wise Software 
Repository.
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During a client installation, a new share point directory is not created. Instead, you 
must specify the share point directory that was configured during the server 
installation.

During creation of a new Wise Software Repository, the share point directory is 
created and shared by the Wise Repository Manager.

See also:

Configuration Best Practices on page 14

Configuration Best Practices
Professional Edition only.

Installing Wise Package Studio - Standard Edition is relatively simple; it can be installed 
in one basic configuration only and typically is installed by a single user on their local 
computer.

When you install Wise Package Studio - Professional Edition in a multi-user 
environment, you have several options for configuring the installation. This section 
describes the configurations that are supported. Review these configurations before you 
install Wise Package Studio.

One important change from previous versions is that the share point directory must 
reside on the same computer as the Wise Package Studio application files. Versions of 
Wise Package Studio earlier than 6.0 did not enforce this. If you are upgrading to 6.0 or 
later, and your share point directory is not on the same computer as Wise Package 
Studio, you must perform the upgrade so that Wise Package Studio is on the same 
computer as the share point directory.

See Upgrading an Unsupported Wise Package Studio Configuration on page 20.

See:

Dedicated Servers Configuration
Dedicated SQL Server Configuration
Single Server Configuration
Additional Wise Package Studio Configurations
Upgrading an Unsupported Wise Package Studio Configuration
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Dedicated Servers Configuration

Professional Edition only.

Recommended environment:

Medium to large packaging teams in multiple locations.

Large number of users connecting at one time.

Teams using Preflight Deployment (requires the Quality Assurance module).

Locate the Web Server as close as possible to the end user desktops on which 
preflight packages will be run.

Computer What to Install

Dedicated Wise 
Package Studio 
Server

Wise Package Studio server

Share point directory

Dedicated SQL Server SQL Server

Wise Package Studio databases

Dedicated Web Server IIS

ASP

ASP.NET

ISAPI extensions

Wise Web applications

Clients Wise Package Studio client

Package Studio 
Server

SQL Server

Web Server

Clients
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Dedicated SQL Server Configuration

Professional Edition only.

Recommended environment:

Medium to large packaging teams in a single location.

Teams not using Preflight Deployment.

Locate the Web server as close as possible to the clients.

Computer What to Install

Wise Package Studio/
Web Server

Wise Package Studio server

Share point directory

IIS

ASP

ASP.NET

ISAPI extensions

Wise Web applications

Dedicated SQL Server SQL Server

Wise Package Studio databases

Clients Wise Package Studio client

Package Studio/Web Server SQL Server

Clients
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Single Server Configuration

Professional Edition only.

Small Team

Recommended environment:

Single, small team (one to five packagers).

Managing 500 or fewer applications.

Team not using Preflight Deployment.

Computer What to Install

Dedicated Server Wise Package Studio server

Share point directory

SQL Server or SQL Server Express

Wise Package Studio databases

IIS

ASP

ASP.NET

ISAPI extensions

Wise Web applications

Clients Wise Package Studio client

Package Studio/Web/SQL Server

Clients
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Single User

Recommended environment: Single user with no expected growth. This configuration is 
not scalable.

Additional Wise Package Studio Configurations

Professional Edition only.

After you have determined which of the supported Wise Package Studio configurations is 
best for your environment, decide whether you need to support multiple Wise Software 
Repositories or databases.

Multiple Wise Software Repositories

In a large enterprise with multiple teams, each team might use a different share point 
directory and Wise Software Repository. Because a Wise Package Studio server can be 
associated with only one active repository at a time, each team must install their 
repository on a different server.

With Enterprise Management Server, members of one team can subscribe to packages 
in a Software Manager database that is managed by another team. In the example 
below, each team has subscribed to packages in the other team’s Software Manager 
database.

Computer What to Install

Dedicated Server Wise Package Studio server

Share point directory

SQL Server or SQL Server Express

Wise Package Studio databases

IIS

ASP

ASP.NET

ISAPI extensions

Wise Web applications

Clients no clients

Package Studio/Web/SQL Server
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Note
For ease of illustration, the single server configuration is shown. This concept also works 
with the other recommended Wise Package Studio configurations.

Additional Workbench Database

With Enterprise Management Server, you can connect to an external Workbench 
database so that users can use its process templates. Do this to maintain master 
process templates in a single database and ensure that all users across your 
organization use the same standard, approved processes.

Team 1 Clients

Team 2 Server

Team 1 subscribes to Team 2’s 
Software Manager database

Team 1 Server

Team 2 subscribes to Team 1’s 
Software Manager database

Team 2 Clients

Team 1 Clients

Team 1 Server

Corporate Server

Uses process templates 
from Corporate Server

Team 2 Clients

Team 2 Server

Uses process templates 
from Corporate Server
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Note
For ease of illustration, the single server configuration is shown. This concept also works 
with the other recommended Wise Package Studio configurations.

Multiple Software Manager Databases

You might want to use multiple Software Manager databases in these instances:

If you import a large number of applications for a large organization, you can use 
multiple databases to reduce the database size.

If you are repackaging for multiple operating systems, you can use a separate 
database for each target operating system.

If your organization has multiple, decentralized departments, each using a different 
set of packages, you can use a separate database for each department. This 
concept is similar to using package groups, but on a larger scale.

Each database should reside on its own server. Running multiple databases on a single 
server degrades performance. In addition, you cannot run the Wise scheduled tasks, 
which import packages and refresh package subscriptions on a server-based installation, 
on more than one database on a single computer.

Upgrading an Unsupported Wise Package Studio Configuration

Professional Edition only.

Although it was not recommended, versions of Wise Package Studio earlier than 6.0 
allowed the share point directory and the Wise Package Studio installation to be on 
different servers. With Wise Package Studio 6.0 and later, this configuration is not 
supported because the Wise Task Manager, a server-side service, requires the share 
point directory and the Wise Package Studio installation to be on the same server.

If you currently have this configuration, you cannot simply move the share point 
directory. Instead:

SQL Server 1
Software Manager 
database 1

Package Studio 
Server
Share point directory

SQL Server 2
Software Manager 
database 2

Clients
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1. Install Wise Package Studio server on the computer that contains the share point 
directory. The server installation does not use up a license unless someone actually 
uses Wise Package Studio on that computer.

2. On each client computer, access the Workbench Preferences dialog box > 
Repository tab and verify that the share point directory on the new Wise Package 
Studio server is specified.

After upgrading, the Wise Package Studio server is on the computer that contains the 
share point directory and the Wise Package Studio clients use this share point directory.

Configuration before upgrading

Configuration after upgrading

Authentication Best Practices
For each Wise Package Studio database (Workbench, Software Manager, and Wise 
Services), you can:

Specify the logon information for a database administrator (DBA).

Define how user names and passwords should be validated:

Package Studio/Web/
SQL Server

Wise Package Studio
Web applications *
Wise databases *

* Can also reside on separate 
servers

Clients

File Server
Share point directory

Web/SQL Server
Web applications *
Wise databases *

* Can also reside on separate 
servers

Clients

Package Studio 
Server

Share point directory
Wise Package Studio
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You can use either SQL Server or Windows NT authentication.

If you have installed SQL Server or SQL Server Express with NT authentication only, the 
Wise Task Manager, which manages operations on the Wise Package Studio server, will 
not work. Therefore, during the Wise Package Studio database configuration, the 
authentication method is changed to mixed mode (NT and SQL). If you have any 
questions about how this change affects SQL Server security, ask your database 
administrator.

(Quality Assurance module only.) For best results with the Preflight Deployment feature, 
use Windows NT authentication for the Wise Services database.

Product Documentation
This documentation assumes that you are proficient in the use of the Windows operating 
system. If you need help using the operating system, consult its user documentation.

Use the following sources of information to learn about this product.

Online Help

The online help contains detailed technical information and step-by-step instructions for 
performing common tasks.

Access help in the following ways:

To display context-sensitive help for the active window or dialog box, press F1.

To select a help topic from a table of contents, index, or search, select Help menu > 
Help Topics.

Reference Manual

All the material in the online help is also available in a .PDF-format reference manual, 
which you can access by selecting Help menu > Reference Manual.

The following tools have separate manuals: ConflictManager, Linux Package Editor, 
Mobile Device Package Editor, Software Manager, Virtual Package Editor, Windows 
Installer Editor, and WiseScript Package Editor.

Getting Started

The Getting Started Guide contains system requirements, installation instructions, and a 
tutorial. You can access a .PDF version of the Getting Started Guide from the Windows 
Start menu.

The installation and repository management sections of the Getting Started Guide are 
also available as online help. In the Wise Repository Manager, select Help menu > Help 
Topics, or click the Help button on any of the Wise Package Studio installation dialog 
boxes.

Environment Authentication Method

Client users have local NT 
accounts.

SQL Server only 
(recommended).

Client users have a domain 
account on the SQL server, and 
have read and write permissions.

Windows NT or SQL Server.
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Release Notes

The product release notes cover new features, enhancements, bug fixes, and known 
issues for the current version of this product. To access the release notes, select Release 
Notes from the Symantec program group on the Windows Start menu.

Windows Installer SDK Help (Windows Installer Editor only)

You can get technical details about Windows Installer from its own help system, which is 

written by Microsoft for a developer audience. In Wise for Windows Installer, select Help 
menu > Windows Installer SDK Help.

Version 4.5 of the Windows Installer SDK Help is provided. If you have obtained a later 
version, links from the Wise product documentation to the Windows Installer SDK Help 
might not work.
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Chapter 2
Installing Wise Package Studio

This chapter includes the following topics:

Installation Options on page 24

Upgrading Wise Package Studio on page 36

Starting Wise Package Studio on page 37

Converting an Evaluation Version to a Production Version on page 39

Installation Options
Wise Package Studio is comprised of several software components. Before you install 
Wise Package Studio, learn about the different product configurations that you can 
install and the options that will meet your requirements.

Standard Edition

Consists of the Workbench interface and tools for package creation. The Standard 
Edition can be installed in one basic configuration only. It typically is installed by a single 
user on their local computer.

See Installing the Standard Edition on page 25.

Professional Edition

Consists of the Workbench interface and tools for package creation, management, and 
and conflict resolution. It also includes the Software Virtualization Agent. However, if 
you install Wise Package Studio on a 64-bit computer, the Software Virtualization Agent 
is not installed and any functionality that requires this agent is unavailable.

You can install Wise Package Studio Professional Edition in several different 
configurations and purchase additional modules that extend its functionality: Quality 
Assurance, Enterprise Management Server.

The Professional Edition has three installation types:

Server
The server installation includes the share point directory and the Wise Package 
Studio databases.

In a single-user environment, you can install the Professional Edition on your local 
computer. In effect, your local computer is the server. We recommend that you do 
this only if you do not plan to add users in the future.

In the more typical group environment, you run the server installation on a shared 
network location. Then, you run the client installation on individual users’ 
computers.

See Installing the Professional Edition, Server on page 27.
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Client
The client installation uses the share point directory and Wise Package Studio 
databases that are installed on the server. In a client installation, you can install the 
Wise Package Studio program files on the client computer, or install shortcuts and 
support files that connect to the Wise Package Studio program files that are installed 
on the server.

See About the Wise Package Studio Client Installation on page 30 and Installing the 
Professional Edition, Client on page 30. 

Web
The Web option appears only if Internet Information Services (IIS) is installed and if 
you enter a serial number for at least one product that includes a Web application 
(Professional Edition, Quality Assurance, or Enterprise Management Server).

Wise Package Studio Web applications are:

Management Reports
Requires an Enterprise Management Server or bundle serial number. This lets 
managers use a Web interface to view management reports stored in the 
Software Manager database without having installed any Wise Package Studio 
software on their computers.

Preflight Data Collector and Preflight Data Analysis
Requires a Quality Assurance or bundle serial number. These applications are 
part of the Preflight Deployment feature and are used for evaluating 
installations.

Wise Web Capture
Requires a Professional Edition serial number. This lets repackagers capture 
installations on a clean machine without installing any additional software.

See Installing Web Applications on page 34.

Enterprise Management Server Module

Installs components needed for project management, viewing reports, accessing 
multiple databases, and automatically importing package information. Includes user and 
group-based security, which can be integrated with NT authentication. It includes 
Management Reports.

This module can be installed only with Wise Package Studio - Professional Edition. Enter 
an Enterprise Management Server or bundle serial number during installation, or 
through User Licensing Setup in Workbench after installation.

Quality Assurance Module

Installs these quality assurance tools: Test Expert and Package Instrumentation. It also 
adds the ability to create new validation modules and validation rules in Package 
Validation.

This module can be installed only with Wise Package Studio - Professional Edition. Enter 
a Quality Assurance or bundle serial number during installation, or through User 
Licensing Setup in Workbench after installation.

Installing the Standard Edition
The Standard Edition consists of the Workbench interface and tools for package creation. 
The Standard Edition can be installed in one basic configuration only. It typically is 
installed by a single user on their local computer.
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For help during installation, click the Help button on any dialog box.

Note
The Wise Package Studio installation is run from an .EXE that installs Wise Package 
Studio and, in the Professional Edition, the Software Virtualization Agent. During 
installation, the Wise Package Studio .MSI file is extracted to \Program 
Files\Symantec\Setup Files\Wise Package Studio. The Software Virtualization Agent 
.MSI file is extracted to \Program Files\Symantec\Setup Files\Software Virtualization 
Solution. Do not delete these files because they are needed for future repairs.

Installing the Standard Edition

1. Close any other applications that are running.

2. To start the installation program, double-click the installation file.

3. On the Welcome page, click Next.

4. On the License Agreement page, read the license terms, mark I accept the license 
agreement, and click Next. 

If you do not accept the license agreement, you cannot continue the installation.

5. Complete the User Information page:

Serial Numbers
Click Add to display a dialog box on which you can enter the serial number.

Serial Number
Enter a serial number for the Standard Edition.

Previous Serial Number
If you are upgrading from a previous version of Wise Package Studio, enter 
the serial number for the previous version. If you don’t know the previous 
version serial number, open Wise Package Studio and select Help menu > 
About. The serial number appears on the About dialog box.

Install Evaluation Version
Mark this to install an evaluation version without a serial number.

Full Name, Organization
Enter this identifying information.

6. Complete the remaining pages, which are described below.

Wise Package Studio Evaluation page

This page appears only when you mark the Install Evaluation Version check box on 
the User Information page.

Mark the option for the edition of Wise Package Studio to install. If you install the 
Professional Edition, you can also mark options to include the Enterprise Management 
Server module and the Quality Assurance module.

Wise Package Studio Directory dialog box

In Destination Directory, specify where to install the Wise Package Studio application 
files.
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Ready to Install the Application page

Click Next to start installing.

Final dialog box

When the installation finishes, a dialog box indicates that the installation has been 
completed successfully.

On the final dialog box, click Finish to exit the installation.

If you are prompted to restart your computer, do so.

Installing the Professional Edition, Server
The Professional Edition consists of the Workbench interface and tools for package 
creation, management, and conflict resolution. The server installation includes the share 
point directory and the Wise Package Studio databases.

For help during installation, click the Help button on any dialog box. For configuration 
recommendations, refer to the configuration best practices.

See Configuration Best Practices on page 14.

Before the Installation

Ensure that SQL Server or SQL Server Express is running on the computer on which 
you will install the Wise Package Studio databases.

If you are upgrading from a previous version of Wise Package Studio, back up the 
existing share point directory and Wise Package Studio databases.

If you use a hidden share for the destination directory, create the directory and 
designate it as hidden before you install Wise Package Studio. Although this 
configuration is allowed, we do not recommend it.

Note
The Wise Package Studio installation is run from an .EXE that installs Wise Package 
Studio and, in the Professional Edition, the Software Virtualization Agent. During 
installation, the Wise Package Studio .MSI file is extracted to \Program 
Files\Symantec\Setup Files\Wise Package Studio. The Software Virtualization Agent 
.MSI file is extracted to \Program Files\Symantec\Setup Files\Software Virtualization 
Solution. Do not delete these files because they are needed for future repairs.

Installing the Professional Edition, Server

1. Close any other applications that are running.

2. To start the installation program, double-click the installation file.

3. On the Welcome page, click Next.

4. On the License Agreement page, read the license terms, mark I accept the license 
agreement, and click Next. 

If you do not accept the license agreement, you cannot continue the installation.

5. Complete the User Information page:

Serial Numbers
Click Add to display a dialog box on which you can enter the serial number.
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Serial Number
Enter a serial number for the Professional Edition. Also enter serial numbers 
for any additional modules that you might have purchased (Quality 
Assurance and Enterprise Management Server).

Previous Serial Number
If you are upgrading from a previous version of Wise Package Studio, enter 
the serial number for the previous version. If you don’t know the previous 
version serial number, open Wise Package Studio and select Help menu > 
About. The serial number appears on the About dialog box.

Install Evaluation Version
Mark this to install an evaluation version without a serial number.

Full Name, Organization
Enter this identifying information.

6. Complete the remaining pages, which are described below.

Wise Package Studio Evaluation page

This page appears only when you mark the Install Evaluation Version check box on 
the User Information page.

Mark the option for the edition of Wise Package Studio to install. If you install the 
Professional Edition, you can also mark options to include the Enterprise Management 
Server module and the Quality Assurance module.

Select Installation Type dialog box

Mark Server.

Wise Package Studio Directory dialog box

In Destination Directory, specify where to install the Wise Package Studio application 
files.

If you use a hidden share for the destination directory, specify its UNC path.

User Account for Wise Server-Side Service dialog box

Wise Package Studio contains a service that lets users on a client computer perform 
certain operations on the Wise Package Studio server. This user account lets the service 
access information it needs to perform these operations. Also, this user account 
becomes the Wise Package Studio server administrator; to use the Wise Repository 
Manager, you must be logged on as this user.

Note
This account is based on the NT account of the currently logged on user. If you prefer to 
run the Wise service under a different account, then cancel the installation, log on with 
that account, and restart the installation.

User
(Read-only.) This defaults to the currently logged on user. It is the same as your 
Windows NT logon.

Password
Enter the password of the currently logged on user.

If this password changes, you must change it in the Wise Repository Manager.
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See Setting the Wise Service Account on page 53.

Web Applications page

Availability of the following options depends on the serial numbers you entered, whether 
IIS is installed, and whether the requirements for Web applications have been met.

Destination Directory
Specify where to install files for Wise Package Studio Web applications.

Management Reports
(Enterprise Management Server only.) This lets managers use a Web interface to 
view management reports that are stored in the Software Manager database 
without having installed any Wise Package Studio software on their computers.

Preflight Data Collector and Preflight Analysis
(Quality Assurance only.) These applications are part of the Preflight Deployment 
feature and are used for evaluating installations.

Wise Web Capture
This lets repackagers capture installations on a clean machine without adding any 
additional software.

If you do not install Web applications now, you can install them later.

See:

Installing Web Applications on page 34
Requirements for Wise Package Studio Web Applications on page 10

Ready to Install the Application page

Click Next to start installing.

When the Installation Finishes

When the Wise Package Studio installation finishes, the Software Virtualization Agent is 
installed if necessary. If the agent is already installed but the version is earlier than what 
Wise Package Studio requires, it is updated.

If you are prompted to restart your computer, do so.

What to Do Next

Before you can use Wise Package Studio, you must configure the repository.

See Configuring the Wise Software Repository on page 45.

If you upgraded from a previous version, you must upgrade the Wise Package 
Studio databases.

See Upgrading the Wise Package Studio Databases on page 46.

If you need to add licenses after the installation is finished, use User Licensing 
Setup in Workbench. See License Management in the Wise Package Studio Help.
Wise Package Studio Getting Started Guide 29



Installing Wise Package Studio
 

About the Wise Package Studio Client Installation

Not available in Standard Edition.

In a client-server configuration, you perform a Wise Package Studio server installation 
on one computer that is designated the Wise Package Studio server, and then you 
perform a Wise Package Studio client installation on multiple client computers. During 
the client installation, Microsoft Data Access Components (MDAC) 2.6 SP2 is installed to 
allow connections to the remote databases.

You can perform a client installation silently from the command line.

See Installing Wise Package Studio Client Silently on page 32.

Two client installations are available: Local and Network. You can use both the Local and 
Network client installation among members of the same team; the only requirement is 
that all users designate the same share point directory.

Local Client

This installs a fully functional version of Wise Package Studio on the client computer. Do 
this when network bandwidth is limited.

Network Client

This is a quick and small installation for repackagers who re-image their computers 
frequently. It installs only the registry settings, .INI files, ODBC data source 
connections, and shortcuts necessary to run the Wise Package Studio applications from 
the packaging server. It also installs MDAC, DAO runtime, MFC support files, Test Expert 
support files, and the Windows Installer runtime.

Why use the Network Client configuration?

It minimizes changes to the client computers for repackaging.

It simplifies and speeds installation on client computers.

It is easier to upgrade and maintain.

Installing the Professional Edition, Client
The client installation uses the share point directory and Wise Package Studio databases 
that are installed on the server. In a client installation, you can install the Wise Package 
Studio program files on the client computer, or install shortcuts and support files that 
connect to the Wise Package Studio program files that are installed on the server.

You can perform a client installation silently from the command line.

See Installing Wise Package Studio Client Silently on page 32.

For help during installation, click the Help button on any dialog box. For configuration 
recommendations, refer to the configuration best practices.

See Configuration Best Practices on page 14.

Before the Installation

Verify that a Wise Package Studio server installation was performed on the server 
that the client will connect to.

Verify that the Wise Software Repository was configured.
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If you will perform a Network Client installation, share the Wise Package Studio 
application directory that was specified during the server installation.

Note
The Wise Package Studio installation is run from an .EXE that installs Wise Package 
Studio and, in the Professional Edition, the Software Virtualization Agent. During 
installation, the Wise Package Studio .MSI file is extracted to \Program 
Files\Symantec\Setup Files\Wise Package Studio. The Software Virtualization Agent 
.MSI file is extracted to \Program Files\Symantec\Setup Files\Software Virtualization 
Solution. Do not delete these files because they are needed for future repairs.

Installing the Professional Edition, Client

1. Close any other applications that are running.

2. To start the installation program, double-click the installation file.

3. On the Welcome page, click Next.

4. On the License Agreement page, read the license terms, mark I accept the license 
agreement, and click Next. 

If you do not accept the license agreement, you cannot continue the installation.

5. Complete the User Information page:

Serial Numbers
Click Add to display a dialog box on which you can enter the serial number.

Serial Number
Enter a serial number for the Professional Edition. Also enter serial numbers 
for any additional modules that you might have purchased (Quality 
Assurance and Enterprise Management Server).

You cannot use an evaluation serial number for the client installation if you 
used a production serial number for the server installation.

Previous Serial Number
If you are upgrading from a previous version of Wise Package Studio, enter 
the serial number for the previous version. If you don’t know the previous 
version serial number, open Wise Package Studio and select Help menu > 
About. The serial number appears on the About dialog box.

Install Evaluation Version
Mark this to install an evaluation version without a serial number.

Full Name, Organization
Enter this identifying information.

6. Complete the remaining pages, which are described below.

Wise Package Studio Evaluation page

This page appears only when you mark the Install Evaluation Version check box on 
the User Information page.

Mark the option for the edition of Wise Package Studio to install. If you install the 
Professional Edition, you can also mark options to include the Enterprise Management 
Server module and the Quality Assurance module.
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Select Installation Type dialog box

Mark Client.

Wise Package Studio Client Selection dialog box

Local Client
Installs a fully functional version of Wise Package Studio on the client computer and 
connects to the Wise Software Repository on the server.

Network Client
Installs shortcuts and support files that connect to a server installation of Wise 
Package Studio.

Wise Share Point Directory dialog box

Specify the share point directory that was configured during the server installation. 
Enter a shared network location in UNC (recommended) or mapped drive notation. 
(Example of UNC: \\Server_Name\Wise Share Point.)

In a large enterprise with multiple teams, each team might have a different share point 
directory and Wise Software Repository. After installation, you can change the repository 
that a client installation connects to. See Setting Repository Preferences in the Wise 
Package Studio Help.

Wise Package Studio Directory dialog box

Local client: Specify a directory on your computer. The Wise Package Studio files will 
be installed there.

Network client: Specify the same Wise Package Studio directory that was specified 
during the server installation. Use UNC (recommended) or mapped drive notation. 
(Example of UNC: \\Server_Name\Wise Package Studio.) Shortcuts and support 
files that connect to that location will be installed on your computer.

A UNC path is required if you use a hidden share for the destination directory.

Ready to Install the Application page

Click Next to start installing.

When the Installation Finishes

When the Wise Package Studio installation finishes, the Software Virtualization Agent is 
installed if necessary. If the agent is already installed but the version is earlier than what 
Wise Package Studio requires, it is updated.

If you are prompted to restart your computer, do so.

Adding Licenses After Installation

If you need to add licenses after the installation is finished, use User Licensing Setup in 
Workbench. See License Management in the Wise Package Studio Help.

Installing Wise Package Studio Client Silently

Not available in Standard Edition.

You can install the Wise Package Studio client and the Software Virtualization Agent 
silently from the command line, using the following Windows Installer command-line 
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options with the installation .MSI. During the server installation, the .MSI is extracted to 
\Program Files\Symantec\Setup Files\Wise Package Studio. 

These options are described in the Windows Installer SDK Help, which is included in 
Windows Installer Editor.

Silent installation properties and values

Silent installations do not validate the share point directory or Wise Package Studio 
directory. Be sure to specify valid paths in the command line.

Installing the Software Virtualization Agent silently

Not available on 64-bit computers. 

Some of the functionality of Wise Package Studio requires the Software Virtualization 
Agent. Therefore, if you install the Wise Package Studio client silently, you must include 
a command line that installs the Software Virtualization Agent. Otherwise, the 
functionality that requires the agent will not work.

When the Software Virtualization Agent installation finishes, a restart occurs. This is 
required for Wise Package Studio and the Software Virtualization Agent to function 
properly.

Obtain the registration key for the Software Virtualization Agent from your server 
installation of Wise Package Studio. On the server, select Start > Settings > Control 
Panel > Symantec SVS. The registration key appears on the About tab of the Symantec 
SVS applet.

/i Installs the product

/qn Runs the installation with no user interface (silent 
installation)

/qb Runs the installation with a basic user interface

SERIALS One or more valid serial numbers

To specify multiple serial numbers, delimit them 
with the pipe (|) character. Example: AAAA-
BBBB-CCCC-DDDD|EEEE-FFFF-GGGG-HHHH

MODE Client

CLIENT Local

Network

SHAREPOINT Valid path to the share point directory

WPSDIR Valid path where the Wise Package Studio 
application files should be installed

For a Network Client installation, specify the 
same Wise Package Studio directory that was 
specified during the server installation.
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Use the following command line when the Software Virtualization Agent is not 
already installed on the client computer.

msiexec.exe /qn /i "PATH to Software_Virtualization_Agent.msi" 
PRODUCT_KEY=registration key

Warning
If you use the above command line on a computer that has the Software 
Virtualization Agent installed, it will uninstall the existing agent and delete all layers. 
If the Software Virtualization Agent is already installed on the computer, use the 
following command line instead.

Use the following command line when the Software Virtualization Agent is installed 
on the client computer. This command line updates the existing installation of the 
agent.

msiexec.exe /qb- /fvamus PATH to Software_Virtualization_Agent.msi 
PRODUCT_KEY=registration key

Example

The following command lines perform a silent, Network Client installation of Wise 
Package Studio and the Software Virtualization Agent. In this example, the client 
computer does not have the Software Virtualization Agent installed.

msiexec.exe /i "C:\WPS_7_00.msi" SERIALS="AAAA-BBBB-CCCC-DDDD" 
MODE="Client" CLIENT="Network" SHAREPOINT="\\Server_Name\Wise Share Point\" 
WPSDIR="\\Server_Name\Wise Package Studio\" /qn

msiexec.exe /qn /i "PATH to Software_Virtualization_Agent.msi" 
PRODUCT_KEY=registration key

See also:

About the Wise Package Studio Client Installation on page 30

Installing Web Applications

Not available in Standard Edition.

Wise Package Studio Web applications are: Management Reports; Preflight Data 
Collector and Preflight Data Analysis; and Wise Web Capture.

Installing a Web application consists of creating a virtual directory for that Web 
application. The Web applications must be installed on a Microsoft Internet Information 
Services (IIS) Web server on your network. You must also ensure that the other 
requirements for the Web applications have been met.

See Requirements for Wise Package Studio Web Applications on page 10.

You can install Web applications on the server that contains Wise Package Studio (the 
Wise Package Studio server), or on a different server.
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Options for Installing Web Applications

See also:

Configuration Best Practices on page 14

To install Web applications from the installation

1. Run the Wise Package Studio installation.

See Installing the Professional Edition, Server on page 27.

2. On the User Information dialog box, enter the Professional serial number you used 
for the original server installation. If necessary, enter any other serial numbers that 
are associated with the Web application you are installing (Quality Assurance, 
Enterprise Management Server).

3. On the Select Installation Type dialog box, mark Web.

4. On the Wise Share Point Directory dialog box, specify the share point directory that 
was configured during the server installation. If you specified a mapped drive during 
the initial configuration, then specify a mapped drive here. Otherwise, use UNC 
notation. (Example of UNC: \\Server_Name\Wise Share Point)

When will you 
install the Web 
applications?

Where will you 
install the Web 
application?

How to install the 
Web applications

During the initial 
installation

On the Wise Package 
Studio server (this 
configuration is 
typical for a single 
user or small group)

See Installing the 
Professional Edition, 
Server on page 27.

After the initial 
installation

On the Wise Package 
Studio server

Install Web 
applications from 
Add/Remove 
Programs (see 
details below).

After the initial 
installation

On a server with no 
Wise Package Studio 
programs or Web 
applications

Install Web 
applications from the 
installation (see 
details below).

After adding a new 
license number for 
Quality Assurance or 
Enterprise 
Management Server 
in Workbench

On the Wise Package 
Studio server or any 
other server that 
contains a Wise 
Package Studio Web 
application

Install Web 
applications from 
Add/Remove 
Programs (see 
details below).

After adding a new 
license number for 
Quality Assurance or 
Enterprise 
Management Server 
in Workbench

On a server with no 
Wise Package Studio 
programs or Web 
applications

Install Web 
applications from the 
installation (see 
details below).
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5. On the Web Applications dialog box, mark the check boxes for the Web applications 
you are installing.

6. Complete the installation.

To install Web applications from Add/Remove Programs

When you install a Web application on a computer that already contains Wise Package 
Studio programs or a Wise Package Studio Web application, use Add/Remove Programs. 
Do not try to run the Wise Package Studio installation because it will perform a repair.

1. Select Start > Control Panel > Add/Remove Programs.

2. On the Add/Remove Programs dialog box, click Wise Package Studio and click its 
Change button.

The Wise Package Studio installation starts and the Application Maintenance dialog 
box appears.

3. Mark Modify and click Next.

4. The User Information dialog box displays the serial number or numbers for the 
existing installation. Accept the default serial numbers. If necessary, enter any other 
serial numbers that are associated with the Web application you are installing 
(Quality Assurance, Enterprise Management Server). 

5. On the Web Applications dialog box, mark the check boxes for the Web applications 
you are installing.

6. Complete the installation.

Upgrading Wise Package Studio
When you upgrade from a previous version of Wise Package Studio, the upgrade 
installation uninstalls the previous version and installs the new version. It does not 
delete the existing share point directory, Wise Package Studio databases, or settings.

To upgrade Wise Package Studio

1. Back up the existing share point directory and Wise Package Studio databases.

2. If your current version of Wise Package Studio uses an MSDE database, upgrade to 
SQL Server Express. Wise Package Studio no longer supports MSDE databases.

See System Requirements on page 8.

3. Run the installation and, on the User Information dialog box, enter a new serial 
number and the previous version serial number.

See Installing the Standard Edition on page 25.
See Installing the Professional Edition, Server on page 27.
See Installing the Professional Edition, Client on page 30.

4. (Professional Edition, Server installation only) After the installation finishes, open 
the Wise Repository Manager to upgrade the share point directory and databases.

See Upgrading the Wise Package Studio Databases on page 46.
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Starting Wise Package Studio
1. Select Start menu > Programs > Symantec > Wise Package Studio > Wise Package 

Studio.

2. If the Wise Package Studio Logon dialog box appears, log on as instructed by your 
Wise Package Studio administrator. (Not available in Standard Edition.)

See Wise Package Studio Logon Options.

If you cannot log on, one or more dialog boxes might appear.

See If Your Logon Fails.

3. Click OK.

The first time you start Wise Package Studio, Workbench opens to the Projects tab. 
The Standard Edition opens a project named Sample Project; the Professional 
Edition opens the Initial Workbench Setup project.

If Your Logon Fails

Not available in Standard Edition.

You cannot log on to Wise Package Studio if:

You have not configured the Wise Software Repository in the Wise Repository 
Manager.

See Configuring the Wise Software Repository on page 45.

You have not been assigned a Wise Package Studio license.

If a serial number is available, you might be assigned a serial number 
automatically. If not, the Assign User Licensing dialog box appears. Mark one or 
more check boxes for the licenses to assign.

With Enterprise Management Server, you cannot be assigned a serial number 
automatically. The Wise Package Studio administrator must assign licenses.

If a serial number is not available, the Add Serial Number dialog box appears.

If you entered a user name from a Windows NT account, and Security Setup 
does not contain a security group that matches the domain group you belong 
to, you are prompted to contact your Wise Package Studio administrator. 
(Enterprise Management Server only.)

Wise Package Studio Logon Options

Not available in Standard Edition.

When you start Wise Package Studio, the Wise Package Studio Logon dialog box 
appears. Obtain your logon information from your Wise Package Studio administrator.

Your entries in this dialog box depend on the type of logon account you use.

See Options on the Wise Package Studio Logon dialog box.
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Types of Wise Package Studio logon accounts

Options on the Wise Package Studio Logon dialog box

Logon account Usage Requirements

Workbench 
account

This account is defined when you are 
assigned a Wise Package Studio 
license. Use it when:

You do not have an Enterprise 
Management Server license.

The computer is not connected to 
a Windows NT domain. Example: 
When you use Wise Package 
Studio on a lab computer.

None.

Current Windows 
NT account

Log on to Wise Package Studio as the 
currently logged-on Windows NT 
user.

The computer must be connected to a 
Windows NT domain.

You must have an Enterprise Management 
Server license.

Security Setup must contain a security group 
whose name matches a valid group in the NT 
domain, and you must be defined in that 
domain group. If you are in multiple NT 
groups, you are logged on under the first valid 
group that is encountered.

Windows NT 
account

Log on to Wise Package Studio with a 
Windows NT account. This account 
can be different from the one that is 
currently logged on to Windows. This 
lets you log on to Wise Package 
Studio from another computer, 
including a remote computer.

The computer must be connected to a 
Windows NT domain.

The remote computer must have Wise Package 
Studio installed.

You must have an Enterprise Management 
Server license.

Security Setup must contain a security group 
whose name matches a valid group in the NT 
domain, and you must be defined in that 
domain group. If you are in multiple NT 
groups, you are logged on under the first valid 
group that is encountered.

Option Workbench account entries Current NT account 
entries

Windows NT account 
entries

User Name (Professional Edition) Type 
your user name from User 
Licensing Setup.

(Enterprise Management 
Server) Type your user 
name from Security Setup.

Leave this box blank. Type your Windows NT 
user name for the 
Windows NT domain.
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Converting an Evaluation Version to a Production 
Version

You can convert an evaluation version of Wise Package Studio to a production version 
without uninstalling the product.

1. Purchase the product and obtain a production serial number.

2. Start Wise Package Studio.

If the evaluation period has not expired, then when the Wise Package Studio 
Evaluation dialog box appears, click Serial Number. The Add Serial Number 
dialog box appears.

If the evaluation period has expired, and a production serial number is not 
available, the Add Serial Number dialog box appears.

If the evaluation period has expired, and a production serial number is 
available, you are assigned a serial number and logged on.

This happens when someone adds production serial numbers to an evaluation 
version of Wise Package Studio. In that case, all evaluation licenses expire.

3. On the Add Serial Number dialog box, enter a production serial number and click 
OK.

The evaluation version is converted to a production version. The next time you start 
Wise Package Studio, the evaluation dialog box no longer appears.

Password (Enterprise Management Server 
only) Type your password from 
Security Setup.

Leave this box blank. Type your password for 
the Windows NT domain.

Use Security From Click (Workbench Database). Leave the default. This 
option is disabled when 
you select the next 
option.

Select the Windows NT 
domain name.

Always Use 
Current Network 
Login

Uncheck this check box. Check this check box.

When you start Wise 
Package Studio in the 
future, you are logged on 
automatically.

Uncheck this check box.

Option Workbench account entries Current NT account 
entries

Windows NT account 
entries
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Chapter 3
Managing the Wise Software Repository

This chapter includes the following topics:

About the Wise Repository Manager on page 41

About the Wise Software Repository on page 41

Starting the Wise Repository Manager on page 43

The Wise Repository Manager Interface on page 43

Configuring the Wise Software Repository on page 45

Upgrading the Wise Package Studio Databases on page 46

Changing Database Settings on page 47

Creating Software Manager Databases on page 48

Creating a New Repository on page 49

Opening a Repository on page 49

Repository Configuration Dialog Boxes on page 50

Choosing a Revision Control System on page 52

Setting the Wise Service Account on page 53

Connecting to an External Workbench Database on page 54

About the Wise Repository Manager
The Wise Repository Manager gives you control over database configuration and 
updates, and lets you see the changes that are made by database updates. The Wise 
Repository Manager provides a view of the Wise Software Repository. The Wise 
Repository Manager is available on the Wise Package Studio server only.

To use the Wise Software Manager, you should be familiar with creating databases and 
registering ODBC data sources. We do not offer technical support for SQL Server or SQL 
Server Express. If you need help, ask your database administrator.

Warning
Do not modify Wise Package Studio databases outside the Wise Repository Manager.

About the Wise Software Repository
Not available in Standard Edition.

The Wise Software Repository™ is a collection of software packages, resources and 
information about those resources, project management information, and quality 
assurance data used by organizations as part of the repackaging process. This scalable 
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repository provides a centralized point for managing software packages at any stage of 
deployment.

The Wise Software Repository consists of:

Share point directory
Contains shared Wise Package Studio files and shared resources that are used to 
create Windows Installer installations. It also contains source files for packages in 
the Software Manager database. All Wise Software Repository databases are 
associated with a specific share point directory.

Workbench database
Stores information that Wise Package Studio creates and uses. Examples: project, 
process, tool, and security information. A repository can contain only one 
Workbench database.

Software Manager database
Contains all software packages and other resources that are used by an 
organization. Other resources include: merge modules, device drivers, Group Policy 
Objects, and standard operating system environment snapshots. A repository can 
contain multiple Software Manager databases.

Wise Services database
(Formerly named Preflight database.) Stores the following data that is generated 
and used by Wise services:

Tasks that are managed by the Wise Task Manager. Examples: importing 
packages; running the Merge Module Wizard; compiling .MSI or .WSI packages 
in Software Manager; remotely compiling packages in Windows Installer Editor.

(Quality Assurance module only.) The results that are generated from deploying 
preflight packages, which are made with Package Instrumentation. These 
results are used by the Preflight Data Collector and Preflight Analysis Web 
applications.

A repository can contain only one Wise Services database.

Multiple Repositories

In a large enterprise with multiple teams, each team might use a different share 
point directory and Wise Software Repository. Because a Wise Package Studio 
server can be associated with only one active repository at a time, each team must 
install their repository on a different server.

A single Wise Package Studio server can contain multiple repositories. However, only 
one repository can be active at a time.

To change the active repository on a Wise Package Studio server, open the repository in 
the Wise Repository Manager.

A Wise Package Studio client can connect to any Wise Software Repository that it can 
access. To change a client’s default repository, use the Workbench Preferences dialog 
box > Repository tab and specify the share point that is associated with an active Wise 
Software Repository.
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Starting the Wise Repository Manager
Not available in Standard Edition.

Requirements

To use the Wise Repository Manager:

You must be logged on to a computer that contains a Wise Package Studio server 
installation.

You must be logged on as the Wise Package Studio server administrator, that is, the 
user account under which Wise Package Studio was installed.

To start the Wise Repository Manager:

After Wise Package Studio is installed, select Start menu > Programs > Symantec > 
Wise Package Studio > Wise Repository Manager.

If the Wise Software Repository has not been configured, the Create New Repository 
wizard starts.

See Repository Configuration Dialog Boxes on page 50.

See also:

The Wise Repository Manager Interface on page 43
Configuring the Wise Software Repository on page 45
Upgrading the Wise Package Studio Databases on page 46
Changing Database Settings on page 47
Creating Software Manager Databases on page 48
Creating a New Repository on page 49
Opening a Repository on page 49
Choosing a Revision Control System on page 52
Setting the Wise Service Account on page 53

The Wise Repository Manager Interface
Not available in Standard Edition.

When the Wise Repository Manager opens, it displays the current repository.
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Wise Repository Manager left pane

The left pane contains a tree structure that represents:

The databases that comprise the Wise Software Repository. If the repository 
contains multiple Software Manager databases, the default is displayed in bold type.

Note
The Subscriptions subfolder displays any databases that are subscribed to from the 
selected Software Manager database. To manage a subscribed database, open the 
repository that it is associated with.

See Opening a Repository on page 49.

Pages that contain settings for Revision Control, the Wise Service account, and 
connecting to an external repository.

Click the top-level folder or a database icon to display help in the right pane.

Click a specific database (in bold type) to display maintenance options in the right pane.

Database needs to be 
updated
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Wise Repository Manager right pane

In the right pane, you can:

Upgrade the database to a new version.

See Upgrading the Wise Package Studio Databases on page 46.

Display a record of completed upgrade actions by clicking Show Log on the toolbar.

Change the database settings.

See Changing Database Settings on page 47.

Configuring the Wise Software Repository
Not available in Standard Edition.

After you install Wise Package Studio, you must configure the Wise Software Repository. 
This consists of defining the following:

The share point directory.

The location of the various Wise Package Studio databases.

The authentication method for each database.

To configure the Wise Software Repository

1. On the Windows Start menu, click Programs > Symantec > Wise Package Studio > 
Wise Repository Manager.

Lists the SQL scripts or command lines 
that the selected action runs

Describes what the selected action 
does

Upgrade actions and 
their statuses
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If the Wise Software Repository has not been configured, the Create New Repository 
wizard starts.

If the wizard does not start, then on the Wise Repository Manager’s File menu, click 
New.

2. Step through the Create New Repository wizard.

See Repository Configuration Dialog Boxes on page 50.

Upgrading the Wise Package Studio Databases
Not available in Standard Edition.

After you upgrade Wise Package Studio, you must upgrade the Wise Package Studio 
databases before you can use them with the new version. You perform this upgrade in 
the Wise Repository Manager.

The  icon next to a database name in the left pane indicates that the database must 
be upgraded before it can be used. When the red X is removed from the icon, you can 
safely use that database with the current version of Wise Package Studio. This can occur 
before all upgrade actions have been completed. That is because the upgrade might 
contain background actions that do not have to be completed before users can begin 
using Wise Package Studio.

To review the changes that the upgrade will make, click an action in the Actions list. 
Information about what that action does is displayed in the Description and Details 
sections. The Upgrade to Baseline action upgrades databases earlier than version 5.6 to 
a baseline format, from which you can upgrade to 6.0 or any later version. (The baseline 
version that appears in the action’s description does not necessarily correspond to any 
product version number.)

To upgrade the Wise Package Studio databases

1. On the Windows Start menu, click Programs > Symantec > Wise Package Studio > 
Wise Repository Manager.

2. In the Wise Repository Manager, do one of the following:

To upgrade all databases On the Wise Repository Manager toolbar, click 
Upgrade.

To upgrade one database 
at a time

In the left pane, click a database name (in bold type). 
Then do one of the following:

To run all uncompleted actions, click Run All.

To run the upgrade actions individually, click the 
first uncompleted action in the right pane and 
click Run. (Uncompleted actions are indicated by 
a status of Pending.) Then repeat for subsequent 
actions. You cannot run the actions out of 
sequence.
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3. If the share point directory must be updated, a prompt appears. Click through the 
prompts to perform the upgrade. When the share point directory upgrade finishes, 
the database upgrade begins.

4. If the database upgrade does not begin, then on the Wise Repository Manager 
toolbar, click Upgrade.

To verify that the database upgrade is running, in the left pane, click the first 
database that contains the red X icon. As the upgrade runs, the status of the 
database actions in the right pane changes to Completed.

5. If your repository contains multiple Software Manager databases, or if one of the 
databases has a name other than the default name, register and upgrade those 
databases separately.

See Registering a Database on page 47.

6. When the database upgrade finishes, a record of the upgrade actions is written to 
WiseAdmin.log. To display the most recent log, click Show Log on the toolbar.

Registering a Database

Not available in Standard Edition.

Do this when you upgrade a repository that contains multiple Software Manager 
databases. During the Create New Repository wizard, you can specify only one Software 
Manager database. Therefore, the other Software Manager databases are not 
registered.

To register a database

1. On the Windows Start menu, click Programs > Symantec > Wise Package Studio > 
Wise Repository Manager.

2. In the Wise Repository Manager, in the left pane, click the Software Manager icon.

3. On the Wise Repository Manager toolbar, click Register.

The Select Data Source dialog box appears. This is a standard Windows ODBC 
connection wizard, which lets you connect to a database through an ODBC data 
source.

4. Connect to the database. If you need help, ask your database administrator.

The database appears in the left pane of the Wise Repository Manager.

5. Upgrade the database.

See Upgrading the Wise Package Studio Databases on page 46.

Changing Database Settings
Not available in Standard Edition.

You can change logon settings for a Wise Package Studio database from the Wise 
Repository Manager.
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To change database settings

1. On the Windows Start menu, click Programs > Symantec > Wise Package Studio > 
Wise Repository Manager.

2. In the Wise Repository Manager, in the left pane, click a database name (in bold 
type).

3. Click Settings in the lower right of the right pane.

The Change Database Settings wizard starts.

4. Complete the following dialog boxes:

Database Administrator Logon Information dialog box

Database Service Logon Information dialog box

See Repository Configuration Dialog Boxes on page 50.

Creating Software Manager Databases
Not available in Standard Edition.

If you plan to import a large number of packages, you might use multiple Software 
Manager databases to reduce the size of the individual databases. Use the Wise 
Repository Manager to create Software Manager databases.

The ability to create a database is unavailable for the Workbench and Wise Services 
databases because a repository can contain only one of each of those databases.

This procedure assumes that you are familiar with creating databases and registering 
ODBC data sources. We do not offer technical support for SQL Server or SQL Server 
Express. If you need help, ask your database administrator.

To create a Software Manager database

1. On the Windows Start menu, click Programs > Symantec > Wise Package Studio > 
Wise Repository Manager.

2. In the Wise Repository Manager, in the left pane, right-click the Software Manager 
icon and select Create New Database.

The Create New Database wizard starts.

3. Complete the following dialog boxes:

Database Identification dialog box

Database Administrator Logon Information dialog box

Creation Options dialog box

See Repository Configuration Dialog Boxes on page 50.

4. To make this the default Software Manager database, right-click the database name 
in the left pane and select Set as Default. The default database name is displayed in 
bold type.

To provide an additional level of security, your database administrator can set 
permissions on tables in the new Software Manager database. This is not required, but is 
an option if you are concerned about unauthorized users changing database tables 
outside Wise Package Studio. For recommendations, see Setting Database Security in 
the Wise Package Studio Help.
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Creating a New Repository
Not available in Standard Edition.

When you create a new Wise Software Repository, all links to the old repository are 
broken, but the data is not deleted. The new repository becomes the default for all Wise 
Package Studio clients that connect to this server.

To create a new repository

1. On the Windows Start menu, click Programs > Symantec > Wise Package Studio > 
Wise Repository Manager.

2. In the Wise Repository Manager, on the File menu, click New.

The Create New Repository wizard starts.

3. Complete the dialog boxes that appear. When you are asked to specify the share 
point directory, specify a share point path that resides under an existing location.

See Repository Configuration Dialog Boxes on page 50.

The new databases are created and associated with the share point directory you 
specified.

To provide an additional level of security, your database administrator can set 
permissions on tables in the new databases. This is not required, but is an option if you 
are concerned about unauthorized users changing database tables outside Wise Package 
Studio. For recommendations, see Setting Database Security in the Wise Package Studio 
Help.

Opening a Repository
Not available in Standard Edition.

In a large enterprise with multiple teams, each team might use a different Wise 
Software Repository. However, a Wise Package Studio server can be associated with only 
one active repository at a time. To change the default Wise Software Repository for a 
server installation, open a new repository.

Note
To change the default repository for a client installation, use the Workbench Preferences 
dialog box > Repository tab and specify the share point that is associated with an active 
Wise Software Repository. See Setting Repository Preferences in the Wise Package 
Studio Help.

If you upgrade from a previous version of Wise Package Studio that has multiple 
repositories, only one repository is upgraded. To upgrade the other repositories, you 
must open them and then upgrade them.

To open a repository

1. On the Windows Start menu, click Programs > Symantec > Wise Package Studio > 
Wise Repository Manager.

2. In the Wise Repository Manager, on the File menu, click New.
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3. On the Wise Share Point Directory dialog box, specify the share point that is 
associated with the repository you are opening and click Next.

If the repository associated with that share point is at the current version, it 
opens in the left pane.

If the repository associated with that share point has not been upgraded, 
additional dialog boxes appear. Complete the dialog boxes to configure the 
repository, and then upgrade the database.

See Repository Configuration Dialog Boxes on page 50 and Upgrading the Wise 
Package Studio Databases on page 46. 

Repository Configuration Dialog Boxes
Not available in Standard Edition.

All or some of the repository setup dialog boxes appear when you:

Configure the repository as part of a new or upgrade installation.

Change database settings.

See Changing Database Settings on page 47

Create a new Software Manager database.

See Creating Software Manager Databases on page 48.

Create a new repository.

See Creating a New Repository on page 49.

Open an existing repository that has not been upgraded.

See Opening a Repository on page 49.

Wise Share Point Directory dialog box

The share point directory stores data that can be shared by team members.

Specify a shared network location. Your entry is converted to UNC notation. This 
directory is created and shared for you.

If you are creating a new repository after the initial installation, you must specify a 
share point path that is shared.

Valid paths for a new share point:

C:\Wise Share Point 2
\\Server\C$\Wise Share Point 2

Invalid path for a new share point: \\Server\Wise Share Point 2

Note
When you perform a server installation in a team environment, we recommend that you 
install the share point directory on the same physical drive that contains the Wise 
Package Studio application files.

File Share Name dialog box

The share point directory must be accessible by other computers. Enter the name of the 
file share to associate with the share point directory.
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Database Identification dialog box

When you create a new repository, this dialog box appears for each database that you 
are defining. When you change a database’s settings or add a Software Manager 
database, this dialog box appears for that specific database only.

Database Name
Specify the database name to create or connect to. If you are creating an additional 
database, use a unique name. Example: Software Manager Database 2.

If you are upgrading from a previous version, do not accept the default name if the 
existing database has a different name. Enter the exact name of the existing 
database.

Note
If you are upgrading from a version earlier than 6.0, the Wise Services database is 
named Preflight. The upgrade process will not change this name.

Server
Select the database server for the database you specified.

Database Administrator Logon Information dialog box

When you create a new repository, this dialog box appears for each database that you 
are defining. When you change a database’s settings or add a Software Manager 
database, this dialog box appears for that specific database only. For recommendations 
on which authentication method to use, see Authentication Best Practices on page 21.

Specify the logon information for a database administrator (DBA) for the selected 
database server:

Windows NT authentication using your current logon credentials
This is the preferred option for the Wise Services database, if you will use the 
Preflight Deployment feature.

SQL Server authentication using a DBA login and password
When you select this, enter a valid Logon ID and Password.

Select this authentication method only if the target database server is configured to 
support SQL authentication.

Define how user names and passwords should be validated:

Windows NT authentication using the user’s Windows logon credentials

SQL Server authentication using a logon ID and password supplied by the 
user
When you select this, you must create users. Do this on the Create New Users 
dialog box. If users will log on with the DBA credentials, you do not have to create 
users.

See Create New Users dialog box on page 52.

Database Service Logon Information dialog box

This dialog box appears only when you change an existing database’s settings.

This account is used to access this database from various background processes 
(examples: package import, the upgrade process). The initial Wise Package Studio 
installation creates this account and generates a random password. If you prefer to 
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manage this password yourself, you can change it here. The password you enter will be 
encrypted.

Create New Users dialog box

This dialog box appears if you specify SQL Server authentication for users. The DBA 
logon information you entered earlier will be used to create database users that you 
specify on this dialog box for all databases that are being created (Workbench, Software 
Manager, Wise Services). These users will have modification privileges in all databases.

For each user, enter a User Name and Password and click Add.

Creation Options dialog box

If the database is not local or the database already exists (example: during an upgrade), 
this dialog box does not appear.

Import sample applications into Software Manager
Import packages for sample applications into the Software Manager database. This 
option lengthens configuration time.

Choosing a Revision Control System
Not available in Standard Edition.

Wise Package Studio contains a Revision Control System, with functions available in 
Software Manager. Use Revision Control to:

Protect packages from unauthorized changes and changes to multiple copies of a 
package at one time.

Track changes to packages.

Revision Control performs standard source control functions, including: check in, check 
out, undo check out, and view and retrieve previous versions. Whereas other source 
control products protect source files used to compile packages, Revision Control protects 
packages.

For details, see Revision Control in the Software Manager Help.

You cannot use both the Wise Revision Control System and a third party source control 
product. Choose which system to use in the Wise Repository Manager.

To choose a revision control system

1. On the Windows Start menu, click Programs > Symantec > Wise Package Studio > 
Wise Repository Manager.

2. In the Wise Repository Manager, in the left pane, click the Revision Control System 
icon.

3. In the right pane:

To use the Revision Control System in Wise Package Studio:

Mark Wise Revision Control System.

Mark Require Comments for Each Revision to require users to enter 
comments each time they check a package back into Revision Control.
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To use a third-party source control product, mark External Revision Control 
System.

The Source Control menu in Windows Installer Editor provides access to the 
external revision control system.

See also:

Starting the Wise Repository Manager on page 43

Setting the Wise Service Account
Not available in Standard Edition.

Wise Package Studio contains a service that lets users on client computers perform 
certain operations on the Wise Package Studio server. By processing operations on the 
server, you reduce the workload of the client computer and, if the packages and 
databases reside on the server, you improve the operation’s performance.

This service requires a user account to access the information it needs to perform these 
operations. This user account is set up when Wise Package Studio is installed on the 
server. If the password for the user account changes, then this service will not work until 
the user’s password is updated in the Wise Repository Manager.

To update the user account password

1. On the Windows Start menu, click Programs > Symantec > Wise Package Studio > 
Wise Repository Manager.

2. In the Wise Repository Manager, in the left pane, click the Wise Service icon.

3. In the right pane, change the password of the user account that is displayed.

See also:

Starting the Wise Repository Manager on page 43
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Connecting to an External Workbench Database
Enterprise Management Server only.

With Enterprise Management Server, you can connect to an external Workbench 
database so that users can use its process templates. Do this to maintain master 
process templates in a single database and ensure that all users across your 
organization use the same standard, approved processes.

For configuration recommendations, see Additional Wise Package Studio Configurations 
in the Getting Started Guide.

Use Wise Repository Manager to connect to an external database by selecting the share 
point directory with which it is associated. When the connection is made, the process 
templates in that database become visible in Workbench, and the predefined process 
templates in the local database become unavailable. If the external share point is 
disconnected or otherwise unavailable, then the predefined process templates in the 
local repository become available. Process templates that users create in their local 
database are always available.

Requirements

The external share point must exist.

Your share point and the external share point must be at the same version.

You must have access to the server on which the external Workbench database is 
stored.

You cannot select your current share point.

If any of these conditions change (example: the external share point’s server becomes 

unavailable), an icon appears in the left pane of Wise Repository Manager, and error 
information appears in the right pane.

To connect to an external database

1. On the Windows Start menu, click Programs > Symantec > Wise Package Studio > 
Wise Repository Manager.

2. In the Wise Repository Manager, in the left pane, click the External Repository icon.

3. In the right pane, specify the share point that is associated with the external 
database.
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Chapter 4
Tutorial

This chapter includes the following topics:

About This Tutorial on page 55

Before You Start on page 56

Import a Sample Package into Software Manager on page 56

Create a New Project on page 58

Create the Package with SetupCapture on page 59

Edit the Package in Windows Installer Editor on page 63

Validate the Package on page 66

Test the Package Without Test Expert on page 66

Test the Package With Test Expert on page 68

Distribute the Package on page 70

Import the Package into Software Manager on page 71

Resolve Conflicts with ConflictManager on page 71

Make the Package Available on page 73

Distribute the Package on page 74

Remove Tutorial Packages from Software Manager on page 74

About This Tutorial

Professional Edition.
This tutorial uses features that are not available in the Standard Edition of Wise Package 
Studio.

This tutorial guides you through the process of repackaging an application into Windows 
Installer format. You use a sample application named QuickFacts, which is included with 
Wise Package Studio, to provide you with a realistic practice scenario. QuickFacts is a 
utility that displays facts and bitmaps. It was created to illustrate the repackaging 
process.

In this tutorial, you will:

Create a new Wise Package Studio project.

Use SetupCapture to recreate the existing installation in Windows Installer format.

Customize the installation package in Windows Installer Editor.

Verify that the package complies with standards.

Test the repackaged installation.
Wise Package Studio Getting Started Guide 55



Tutorial
 

Detect and resolve conflicts in ConflictManager.

Deploy the application to end users.

If you are using Enterprise Management Server, security settings can limit access to 
some features. See your manager or system administrator if a feature described in this 
tutorial is not available.

Note
This tutorial does not cover details of the Wise Package Studio tools. Press F1 on any 
window or dialog box for context-sensitive help.

Before You Start
Make sure you are using the Professional Edition. This tutorial uses features that are 
not available in the Standard Edition.

Obtain Wise Package Studio logon information.

If you are using an evaluation version of Wise Package Studio, you can log on as 
Admin and leave the password blank.

If you are using a production version, ask your manager or Wise Package Studio 
administrator for logon information.

Close other applications before starting this tutorial. During the repackaging 
process, you capture the actions performed by an installation; it is important to 
close all applications other than Wise Package Studio to avoid capturing the 
activities of other applications and processes.

This tutorial assumes that you are installing the sample application, QuickFacts, on 
your computer for the first time. If you have installed QuickFacts on your computer, 
uninstall it and remove any files and registry keys related to it. Files left from 
previous installations can cause your results to deviate from the information 
presented in this tutorial.

Import a Sample Package into Software Manager
In this procedure, you import a sample package into the Software Manager database. 
Later in the tutorial, you will detect conflicts between this sample package and the new 
package you create.

Frequently, you will need to import a package into the Software Manager database 
without repackaging. You might do this with a package that has already been approved 
and deployed so that all packages that have been installed throughout your company 
are in the Software Manager database.

To import a sample package into Software Manager

1. Select Start menu > Programs > Symantec > Wise Package Studio > Wise Package 
Studio.

The Wise Package Studio Logon dialog box appears.

2. Enter your logon information and click OK.

Wise Package Studio opens.

3. Click the Tools tab. At the top of the Tools tab, double-click Software Manager.
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Software Manager opens.

4. Select Packages menu > Import.

The Import Type page appears.

5. Mark Import a single file into the Software Manager database and complete 
the page:

File
Browse to the Tutorial subdirectory under the Wise Package Studio directory 
and open Sample Conflict.msi.

Distribute source files to the share point directory
Mark this check box to copy the package’s source files to the share point 
directory.

Overwrite existing application and package
Mark this check box to overwrite any package that is already in the database 
with the same application and package names.

Do not modify the original package
Normally, when you import a Windows Installer installation (.MSI or .WSI), the 
original installation file is updated with Wise-specific version information that 
speeds future subscriptions and imports of the installation. Mark this to prevent 
the original file from being changed.

Perform this operation on the Wise Package Studio Server
Clear this check box.

Add to Revision Control
Clear this check box.

Detect conflicts during package import
Clear this check box.

6. Click Next on the Import Type page.

The Package Details page appears.

7. Complete the Package Details page:

Application Name
Enter Sample Conflict. This identifies the application in the Software Manager 
database.

Package Name
Enter Conflict 1.0. Typically, you use the application name plus specific version 
information as the package name.

Use Transactions for Import
Leave this check box cleared.

8. Click Next on the Package Details page.

The Transforms and Patches page appears.

9. Click Finish.

The Wise Task Manager appears, then closes.

The package you selected is imported into the Software Manager database. It 
appears on the Applications/Packages pane in Software Manager.

10. Close Software Manager.
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The right pane in Workbench reappears.

You have finished importing a package into the Software Manager database. Next, you 
will create a new project in Wise Package Studio.

Create a New Project
In this procedure, you create a new project named QuickFacts in Wise Package Studio. 
The project defines the name and location of files, as well as the project name and other 
information. You also assign a repackaging process to the project. This process contains 
tasks that you will complete as you follow this tutorial. The tasks guide you through the 
basic steps of repackaging. All tasks automatically access the appropriate project files.

Note
Follow the instructions exactly as presented, otherwise your results can deviate from the 
information presented in this tutorial.

To create a new project

1. If Wise Package Studio is not open, open it and log on.

2. Select File menu > New Project.

The Project Setup dialog box appears. A new project appears in the Project list on 
the left and is selected by default.

3. Complete the right pane:

Project Name
Enter: QuickFacts

Project Directory
Leave the default.

Status
Leave the default of Open.

Product Vendor
Select Symantec.

Application Name
Enter: QuickFacts

Package Name
Enter: QuickFacts version 3.0

File Name
If a default file name does not appear, type QuickFacts

Vendor Package

Do not type in this field. Instead, click the  button next to the field. Navigate 
to the Tutorial subdirectory under the Wise Package Studio directory and open 
QuickFactsInstall.exe.

Project Owner
This field appears with Enterprise Management Server only. Leave the default.
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Process
Select Repackage for Windows Installer. The Repackage for Windows 
Installer process contains the tasks for repackaging an installation into a 
Windows Installer package.

4. On the Project Setup dialog box, click Close.

5. If the Projects tab is not displayed in the left pane of Wise Package Studio, click it. 

6. From Active Project, select QuickFacts.

The Projects tab displays the process you’ll follow to repackage the QuickFacts 
application. This process consists of a set of tasks that appear in the Task list.

Note
If a task is disabled, it means that you do not have a license to use the tool associated 
with it. With Enterprise Management Server, it might also mean that you do not have 
permission to use the tool associated with the task or have not been assigned as the 
task’s owner.

You have finished creating a new project. Next, you will create a new package by 
capturing the QuickFacts installation.

Create the Package with SetupCapture
In this procedure, you repackage the existing QuickFacts installation program, which is 
the first step in the Application Integration phase. The Create package task runs 
SetupCapture, which records an installation and recreates it in Windows Installer Editor. 
SetupCapture also copies the directory structure and source files of the installation to 
the Projects\QuickFacts subdirectory in your share point directory. The repackaged 
installation that results from this SetupCapture will reference the source files in your 
share point directory rather than those installed in the Program Files directory.

Before you follow this procedure, you must have created the project.

See Create a New Project on page 58.

The Active Project is the one 
you are currently working on.

Process, made up of tasks. 
You’ll follow these tasks to 
repackage the sample 
application.
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Note
Normally, you perform SetupCapture on a clean machine, which represents the base 
computer for your organization, and you restart during the capture. However, in this 
tutorial, the installation you are capturing does not require a clean machine or a restart.

To create the package with SetupCapture

1. Close all applications other than Wise Package Studio. This includes background 
applications that might create or change files on the computer. (Example: Norton 
AntiVirus.)

2. In Wise Package Studio, click the Projects tab. QuickFacts should appear in the 
Active Project drop-down list.

3. Click the Run link next to the Create package task.

The Welcome page appears.

4. Click Settings.

The SetupCapture Configuration dialog box appears.

5. Set .TMP files to be excluded.

a. Click the File and Folder Exclusions tab.

b. If a message about file exclusions located under your user profile appears, click 
Yes.

c. Click Add on the File and Folder Exclusions tab.

d. The File Exclude dialog box appears.

e. Leave the Directory field blank.

f. In File/Wildcard, enter *.tmp and click OK on the File Exclude dialog box.

This adds *.tmp to the list of files that SetupCapture will ignore when it 
captures an installation.

6. On the Directories to Watch tab, note the drive letter that will be watched so that 
you can install QuickFacts to this drive later in the tutorial.

7. Click OK on the SetupCapture Configuration dialog box.

The Welcome page reappears.

8. Click Next on the Welcome page.

The Capture Methodology page appears.

9. Complete the Capture Methodology page:

Mark Snapshot.

Clear Use SmartMonitor in conjunction with Snapshot.

Click Next.

Note
Snapshot comparisons determine the difference between a “before” snapshot of the 
system and an “after” snapshot to determine what happened during the installation.

What happens next depends on whether SetupCapture previously scanned your 
computer.
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If SetupCapture previously scanned your computer, the Initial Scan page 
appears.

If SetupCapture did not previously scanned your computer, SetupCapture skips 
the Initial Scan page.

10. If the Initial Scan page appears, mark Rerun the initial scan and click Next.

The Begin Installation Capture page appears.

11. Click Next on the Begin Installation Capture page.

SetupCapture scans your computer; this might take several minutes. When the scan 
finishes, the Execute Installation page appears. The vendor package that you 
specified in the QuickFacts project appears in the .EXE Name field. This is the 
installation that you will capture.

12. Click Execute on the Execute Installation page.

The QuickFacts Setup program opens in front of SetupCapture.

13. Step through the QuickFacts Setup program, accepting all default settings.

This installs a sample application named QuickFacts on your computer.

14. When the QuickFacts installation finishes, click Next on the Execute Installation 
page.

The End Installation Capture page appears.

15. Click Next on the End Installation Capture page.

SetupCapture scans your computer for a second time to determine what changed. 
This might take several minutes. When the scan finishes, the SetupCapture 
Inclusions page appears, which lists all the files, registry entries, shortcuts, and .INI 
file changes that will be included in the repackaged installation.

Note
Typically, you exclude from your installation those files and registry entries that are 
not applicable to all computers, or are not applicable to Windows Installer 
technology. Additional files that are not related to QuickFacts might be included in 
the list. Examples: temporary Internet files, cookies, and files that have to do with 
software that runs constantly in the background, such as virus protection software.

16. Exclude all files except the QuickFacts files listed below.

License.txt
QckFacts.exe
ReadMe.txt
Birds.bmp
Birds.qft
Cats.bmp
Cats.qft
Dogs.bmp
Dogs.qft
QuickFacts.cnt
QuickFacts.hlp
QFGUITAM.dll

17. Select Registry keys from Inclusion Type and exclude all registry keys except:

Those with QuickFacts or QckFacts in their Key name.
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Registry keys for file associations, which vary by operating system. The list 
should include registry keys with the following ValueNames:

CaptionFontName
FactsBkColorBlue
FactsBkColorGreen
FactsBkColorRed
TitleFontSize
TitleText

Note
When you become familiar with your particular operating system environment, you 
will more easily know what files and registry entries are extraneous to an 
application. You can also run SetupCapture Configuration to build an exclusion list to 
further reduce extraneous files and registry entries.

18. Click Next on the SetupCapture Inclusions page.

The SetupCapture Exclusions page appears, which shows the registry keys that will 
be excluded from the repackaged installation.

Change Exclusion Type to Files to see the files that are excluded. There might be 
additional files and registry keys other than those you excluded if you have 
previously run/configured SetupCapture or if they are in the default SetupCapture 
exclusion list. Example: The files INSTALL.LOG and Unwise.exe appear because they 
are in the default SetupCapture exclusion list.

19. Click Next on the SetupCapture Exclusions page.

The Finish page appears.

20. The fields should appear exactly as shown below, if the Program Files directory is 
located on your C: drive. If the fields do not appear as below, edit them.

21. Click Finish.
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22. If the Files in Repository dialog box appears, click OK.

This saves the captured installation in Windows Installer format and copies the directory 
structure and source files of the installation to the Projects\QuickFacts subdirectory of 
your share point directory. This lets you create and edit your QuickFacts.msi package 
using relative paths, independent of the original installation.

You have finished capturing the QuickFacts installation. On the Projects tab, the check 
box next to the Create package task is marked to indicate that the task is complete. 
Next, you will customize the QuickFacts installation.

Edit the Package in Windows Installer Editor
In this procedure, you open the QuickFacts installation package you captured in the 
previous procedure, and then customize it for your organization. The Edit Package task 
runs Windows Installer Editor, which is an installation development environment for 
Windows Installer.

Windows Installer Editor has three views: Installation Expert, MSI Script, and Setup 
Editor. Each view provides a different development environment. In this tutorial, you use 
various pages in Installation Expert. Each page lets you review and edit a specific aspect 
of your installation.

Before you follow this procedure, you must have created the package.

See Create the Package with SetupCapture on page 59.

To edit the package in Windows Installer Editor

1. Make sure you are in Wise Package Studio with the Projects tab selected and 
QuickFacts selected in the Active Project drop-down list.

2. Click the Run link next to the Edit package task.

The repackaged QuickFacts installation (QuickFacts.wsi) opens in Windows Installer 
Editor.

3. Make sure you are in Installation Expert by clicking the Installation Expert tab at the 
lower left of the window.

Note
Along the left side of the window are page group headings (example: Project 
Definition), below which appear linked page names. Click a page group name 
(example: Project Definition) to expand or collapse it. Click the page names below 
the page group names to go to a particular page.

4. In the Project Definition page group, click Product Details.

The Product Details page appears, which contains the installation’s meta data. 
Because you entered much of the required information during SetupCapture, most 
of the fields are populated.

Enter the information that is not populated:

Application
Enter: QuickFacts

Package
Enter: QuickFacts version 3.0
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Product Type
(Read-only)

Product Name
QuickFacts

Manufacturer
Symantec.

Version
3.0

Default Directory
Program Files\QuickFacts

Package Path
(Read-only)

Product Code
Leave the default. This is a unique code, called a GUID, that Windows Installer 
uses to identify the product.

Target Platform
(Read-only.)

Application Type
Make sure this is set to Win32 (non .NET).

Installation Target
Make sure this is set to Windows-based desktop/server PC.

Description
(Optional.) Enter: This is a sample application

5. (Optional.) In the Project Definition page group, complete the General Information 
page and the Add/Remove Programs page. To display context-sensitive help on 
these or any other Installation Expert pages, press F1.

The information on the General Information page appears if an end user right-clicks 
on the installation .MSI in Windows Explorer and selects Properties. The information 
on the Add/Remove Programs page appears in the Add/Remove control panel for 
QuickFacts (Windows 2000 or later only).

6. In the Project Definition page group, click Features.

The Features page appears.

7. Expand the Complete feature tree.

A subfeature, named Feature, appears under the Complete feature. The 
QckFacts.exe file and its advertised shortcut are isolated in a separate feature to 
avoid a common performance issue related to Windows Installer repair functionality. 
The issue can cause repeated attempts to repair the application. Isolating the 
advertised .EXE and its shortcut fixes the problem. By default, the feature named 
Feature is hidden from the end user.

8. On the Features page, rename Feature to MainApp:

a. Double-click the word Feature in the feature tree.

b. The Feature Details dialog box appears.

c. In both the Name and Title fields, type MainApp

d. Leave the defaults in the remaining fields.
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e. Click OK on the Feature Details dialog box.

9. In the Feature Details page group, click Files.

The Files page appears and the files for the MainApp feature are displayed. To see 
the files for the Complete feature, select Complete from the Current Feature 
drop-down list at the top of the page. The Current Feature drop-down list indicates 
the number of files in each feature. In the lower-left list box, expand the QuickFacts 
folder to see the directories for that feature. The files in each directory are displayed 
in the lower-right list box.

10. (Optional.) Review the shortcuts and registry entries by selecting the Shortcuts and 
Registry pages in the Feature Details page group. Only the shortcuts or registry 
entries for the current feature appear. If no entries appear, change the current 
feature by selecting the feature name in the Current Feature drop-down list at the 
top of the page.

11. In the Target System page group, click System Requirements. You might have to 
scroll down to see the Target System page group.

The System Requirements page appears, where you change the system 
requirements of this installation:

a. Double-click the Windows Version requirement.

b. On the Minimum System Requirements dialog box, select Windows XP from 
Windows Version. This allows the program to install on Windows XP or later.

c. In Message Text, enter:

You must have Windows XP or later to run this installation.

d. Click OK on the Minimum System Requirements dialog box.

e. Leave the Windows NT requirement set to All Versions, which includes 
Windows NT 4.0, Windows 2000, and later. 

12. In the User Interface page group, click Dialogs.

The Dialogs page appears, where you specify which dialog boxes appear, and you 
specify a ReadMe file to display:

a. Turn off the User Information dialog box by clearing its check box.

b. Turn on the Readme dialog box by marking its check box.

c. Select the Readme dialog box and click Import Text, which is to the right of the 
dialog box preview.

d. On the Open dialog box, navigate to share point\Projects\QuickFacts\Program 
Files\QuickFacts, where share point is the path to your share point directory. 
This is the location of the source files for this package, which were copied during 
SetupCapture. Change the Files of type drop-down list to Text files (.txt). 
Open the ReadMe.txt file.

The ReadMe text appears in the Readme Information dialog box preview and 
will appear in this dialog box during installation.

13. Save the installation by selecting File menu > Save.

14. Close Windows Installer Editor.

You have finished customizing the QuickFacts installation, which completes the 
Application Integration phase of the Repackaging for Windows Installer process. On the 
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Projects tab, the check box next to the Edit package task is marked to indicate that the 
task is complete. Next, you will validate the package you created.

Validate the Package
In this procedure, you validate the QuickFacts package, which is the first step in the 
Package Testing phase. The Validate compliance with standards task runs Package 
Validation, which checks the internal consistency of the Windows Installer tables. 

Before you follow this procedure, you must have edited the package.

See Edit the Package in Windows Installer Editor on page 63.

To validate the package

1. Make sure you are in Wise Package Studio with the Projects tab selected and 
QuickFacts selected in the Active Project drop-down list.

2. Click the Run link next to the Validate compliance with standards task.

Dialog boxes appear briefly and the .WSI is compiled into a .MSI. The Welcome page 
for the Package Validation tool appears, listing the predefined validation tests that 
can be performed. To see a description of each test, click the test name, and the 
description appears at the right of the page.

3. Mark Windows Installer SDK Internal Consistency only. If necessary, clear all 
other check boxes.

4. Click Next.

The test runs. This might take a few minutes. When the test finishes, the View / 
Correct page appears, which lists all the possible problems detected.

Normally, no errors appear for QuickFacts, although for more complex installations, 
errors are more likely to appear. If there were errors and if the Correct button 
became enabled when the error was selected, you could click Correct to resolve the 
problem. Otherwise, you would open the installation in Windows Installer Editor, fix 
the error, and recompile. Errors are documented in the Windows Installer SDK Help. 
Start with the topic Internal Consistency Evaluators - ICEs.

5. Click Finish on the View / Correct page.

You have finished validating the QuickFacts installation package. On the Projects tab, the 
check box next to the Validate compliance with standards task is marked to indicate that 
the task is complete. Next, you will test the package.

If you have Test Expert, which comes with the Quality Assurance module, you will 
use it to test.

See Test the Package With Test Expert on page 68.

Otherwise, test the package without Test Expert.

See Test the Package Without Test Expert.

Test the Package Without Test Expert
Note
Follow this procedure if you don’t have the Quality Assurance module. If you have the 
Quality Assurance module, skip this procedure and test the package without Test Expert.
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See Test the Package With Test Expert on page 68.

In this procedure, you test the QuickFacts package. The Test package task installs the 
QuickFacts application on your computer. Then you perform tests to verify that the 
application works as expected.

Normally, a package would require more thorough testing. To test in a corporate 
environment, you would copy the finished .MSI file to a file server or other media, such 
as a CD. Then you would install the application on computers that are representative of 
the target computers and test it.

Before you follow this procedure, you must have validated the package.

See Validate the Package on page 66.

To test the package without Test Expert

1. Use Add/Remove Programs from Control Panel to uninstall the copy of QuickFacts 
that you installed during the first part of this tutorial.

You uninstall because during this procedure, you install and test the repackaged 
version of QuickFacts. Removing the original QuickFacts ensures that you test only 
the repackaged installation.

2. Make sure you are in Wise Package Studio with the Projects tab selected and 
QuickFacts selected in the Active Project drop-down list.

3. Click the Run link next to the Test package task. The repackaged QuickFacts 
installation begins.

4. Step through the installation, accepting all the defaults.

5. After the installation finishes, open QuickFacts.

6. To check the QuickFacts installation, verify that its:

Shortcuts were created

Registry entries were created

Files were installed

7. To test the QuickFacts application, use every function.

In the Select an item to see facts list, select all three items, one at a time.

Select Help menu > Help Contents.

Select Help menu > QuickFacts Readme.

Click About in the lower right of the QuickFacts dialog box.

8. Unlike with other tasks, the check box next to the Test package task is not marked, 
because additional testing might be necessary (example: testing on a clean 
machine). In this tutorial, you will not perform additional testing. On the Projects 
tab, mark the check box next to the Test Package task.

You have finished testing the package installation.

Next, you will distribute the package to the share point directory. Skip the next section, 
which is applicable only if you have the Quality Assurance module.

See Distribute the Package on page 70.
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Test the Package With Test Expert

Quality Assurance module only.
If you don’t have the Quality Assurance module, skip this section and test the package 
without Test Expert.

See Test the Package Without Test Expert on page 66.

In this procedure, you perform integration and acceptance testing of the QuickFacts 
package. The Test package task runs Test Expert, which generates a master test plan 
based on the contents of a package and guides you through the execution of various test 
cases. This makes the testing process more efficient and focused, eliminating the 
random approach often used in an ad hoc testing environment. Test Expert performs 
analysis on .MSI-based installations only.

Before you follow this procedure, you must have validated the package.

See Validate the Package on page 66.

Note
Under normal testing conditions, Test Expert requires a clean machine to ensure the 
integrity of the repackaged installation.

To test the package with Test Expert

1. Use Add/Remove Programs from Control Panel to uninstall the copy of QuickFacts 
that you installed during the first part of this tutorial.

You uninstall because during this procedure, you install and test the repackaged 
version of QuickFacts. Removing the original QuickFacts ensures that you test only 
the repackaged installation.

2. Make sure you are in Wise Package Studio with the Projects tab selected and 
QuickFacts selected in the Active Project drop-down list.

3. Close all applications other than Wise Package Studio, including background 
applications that might create or change files on the computer.

4. Click the Run link next to the Test package task.

Dialog boxes appear briefly and the package is recompiled. The Test Expert window 
appears, with QuickFacts.msi opened.

Note
If Test Expert does not open, it means you don’t have the Quality Assurance 
module. Test the package without Test Expert.

See Test the Package Without Test Expert on page 66.

When you open a package in Test Expert, the Master Test Plan for that package is 
displayed. Each time you open the package, the package is read and test cases are 
generated based on the contents of the package. In addition to the Master Test Plan, 
you can add user-defined test cases to fully test the package for the requirements of 
your organization. In this tutorial, you perform only two of the test cases provided in 
the Master Test Plan.

5. In the Installation Tests section in the left pane, select the Verify Installation test 
case.
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The Verify Installation page appears in the right pane. This test case ensures that 
the installation runs without errors by installing the QuickFacts package you created 
during SetupCapture.

6. Click Install on the toolbar at the top of the window. Then, in the Welcome page, 
click Cancel to skip the Machine Capture.

Machine Capture is necessary only if you plan to perform Uninstall Tests, which are 
skipped in this tutorial.

The QuickFacts Setup program opens in front of Test Expert.

7. In the QuickFacts Setup program, step through the installation, accepting all default 
settings. This installs the QuickFacts package. 

8. If the QuickFacts installation ran without errors, from Status of Test Case, select 
Passed. A check mark icon appears next to the Verify Installation test case.

9. In the Application Execution Tests section, select the File Coverage test case.

A list of all files accessed by the QuickFacts application appears on the All Test Items 
tab in the right pane. The File Coverage test case indicates which installed files are 
accessed as the application is run.

10. Click Run on the toolbar.

The Run Application Execution Tests dialog box appears.

11. In the File to Run list, select QckFacts.exe and click OK.

The QuickFacts application opens and the Application Monitor window appears.

Note
You must leave the Application Monitor window open while you exercise the 
functionality of the application because your system is monitored only when it is 
open. Move or minimize it if necessary.

12. To test the QuickFacts application, use every function.

In the Select an item to see facts list, select all three items, one at a time.

Select Help menu > Help Contents.

Select Help menu > QuickFacts Readme.

Click About in the lower right of the QuickFacts dialog box.

As files are accessed, the Application Monitor window is updated. When you finish 
testing, the File Coverage graph in Application Monitor indicates the percentage of 
the files that were accessed.

Note
Some files are not accessed by an application during normal use. Example: In the 
QuickFacts application, License.txt is not accessed during normal application 
execution.

13. To return to Test Expert, click Exit in the QuickFacts application and close the 
QuickFacts ReadMe.

14. Close the Application Monitor window. Monitoring does not stop until it is closed.
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On the All Test Items tab, all files except License.txt should display the Passed 
status. Because the License.txt file is not accessed during normal application 
execution, it has a Pending status. The test items should look like this:

15. To set the status of the License.txt file to Passed, double-click the License.txt file 
on the All Test Items tab.

The Test Item Details dialog box appears.

a. From Status, select Passed.

b. In Test Details, type:

This file is not accessed during normal application execution.

c. Click OK.

16. On the File Coverage page, from Status of Test Case, select Passed.

Note
You might notice that the bold type is removed from all test case names under 
Application Execution Tests, which indicates they have been run. This is because all 
Application Execution Tests are run simultaneously.

17. Close Test Expert.

For the purposes of this tutorial, you have finished testing the package. Normally, you 
would execute all test cases. On the Projects tab, the check box next to the Test package 
task is marked to indicate that the task is complete. Next, you will distribute the 
package to the share point directory.

Distribute the Package
In this procedure, you distribute the QuickFacts package to the share point directory so 
that it can be imported into the Software Manager database. The Distribute to share 
point directory task runs Package Distribution silently, which places the package into a 
queue for later import by Software Manager.

Before you follow this procedure, you must have tested the package.

See Test the Package Without Test Expert on page 66 or Test the Package With Test 
Expert on page 68. 
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To distribute the package

1. Make sure you are in Wise Package Studio with the Projects tab selected and 
QuickFacts selected in the Active Project drop-down list.

2. Click the Run link next to the Distribute to share point directory task.

A dialog box appears briefly and the package is copied to the share point directory.

You have finished distributing the package to the share point directory. On the Projects 
tab, the check box next to the Distribute to share point directory task is marked to 
indicate that the task is complete. Next, you will import the package into the Software 
Manager database.

Import the Package into Software Manager
In this procedure, you import the QuickFacts package into the Software Manager 
database. The Import into Software Manager database task runs Software Manager 
silently, which imports the package. Software Manager administers the information 
stored in the Software Manager database.

Before you follow this procedure, you must have distributed the package.

See Distribute the Package on page 70.

To import the Package into Software Manager

1. Make sure you are in Wise Package Studio with the Projects tab selected and 
QuickFacts selected in the Active Project drop-down list.

2. Click the Run link next to the Import into Software Manager database task.

A dialog box appears briefly and the package is imported into the Software Manager 
database.

You have finished importing the QuickFacts package into the Software Manager 
database. On the Projects tab, the check box next to the Import into Software Manager 
database task is marked to indicate that the task is complete. Next, you will detect and 
resolve software conflicts.

Resolve Conflicts with ConflictManager
In this procedure, you compare the QuickFacts package to the Sample Conflict package 
you imported earlier. The Resolve conflicts task opens ConflictManager, which detects 
and resolves software conflicts before you deploy applications throughout your 
organization.

By default, conflict detection is set to run automatically when you import a package into 
the Software Manager database. This is controlled by the Detect conflicts during 
package import check box in Conflict Settings. You can override this setting for specific 
packages during package import, by marking or clearing the Detect conflicts during 
package import check box on the Import Type page.

Because conflict detection was run during package import, you do not have to detect 
conflicts in this step.

Before you follow this procedure, you must have imported the package into Software 
Manager.

See Import the Package into Software Manager on page 71.
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To resolve conflicts with ConflictManager

1. Make sure you are in Wise Package Studio with the Projects tab selected and 
QuickFacts selected in the Active Project drop-down list.

2. Click the Run link next to the Resolve conflicts task, which starts ConflictManager.

If the Detect Conflicts dialog box appears, click Cancel.

3. Expand the QuickFacts tree in the Applications/Packages pane and select the 
QuickFacts version 3.0 package.

In the Conflict List pane, a conflict for QFGUITAM.dll appears. The red exclamation 
point next to it indicates that it is classified as an error. If warnings existed, which 
are not as serious as errors, they would appear in this list with yellow question mark 
icons.

4. To fix the conflict, select Conflicts menu > Resolve.

The Welcome page of the Resolve wizard appears.

5. From Application, select QuickFacts.

QuickFacts version 3.0 appears in the Package field.

6. From Isolation method, select Isolated Components.

Isolating a conflict means that each application will use its own version of the 
conflicting file. The files will be stored in different directories, and will be managed 
by Windows Installer.

7. Click Next.

The File Conflicts page appears. The upper list box contains the name and 
information of the file in your package that has conflicts (QFGUITAM.dll). The lower 
list box contains the package and file that QFGUITAM.dll conflicts with.

8. Select QFGUITAM.dll in the upper list box and click Move on the right of the File 
Conflicts page.

The exclamation point becomes white to indicate that the problem has been fixed. 
Because you selected Isolated Components as the Isolation Method, the Move 
button isolates the file so that each package that uses QFGUITAM.DLL will use its 
own version. This means that a copy of QFGUITAM.DLL will be installed into the 
QuickFacts directory, and QuickFacts will reference its own copy of the .DLL file.

9. Click Next on the File Conflicts page.

The File Conflicts in Registry page appears, which should be empty.

10. Click Finish.

In the Conflict List pane, a yellow question mark icon appears next to QFGUITAM.dll. 
The file conflict has been resolved by isolating the file in different directories but is 
still listed as a warning. This is because two installation packages install a non-16-
bit file with the same file name but different file information (file version number or 
date/time) to different directories. Also, the File Conflicts bar graph in the Summary 
pane indicates one warning.

11. To view only errors (red exclamation points) in ConflictManager, not warnings 
(yellow question marks), do the following:

a. Select Conflicts menu > Filter to display the Filters dialog box.

b. In the Conflict Types to Display section, clear Warnings.
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c. Click OK.

The conflict filter is globally set to show only errors in the Conflict List pane.

12. Select Packages menu > Export and Recompile.

The Export Changed Packages and Recompile dialog box appears, listing the 
QuickFacts package.

13. Mark the check box for the QuickFacts package. Also, mark Compile the packages 
after export and click OK.

Several progress dialog boxes appear briefly during the export.

14. When progress dialog boxes stop appearing, close ConflictManager.

The file change is made in the QuickFacts.wsi file with which you’ve been working, 
which is in the Projects\QuickFacts subdirectory of the share point directory. It is 
also compiled to a file named QuickFacts.msi. The conflict that it had with the 
Sample Conflict package is now resolved because each package will use its own 
version of the .DLL file instead of one .DLL overwriting the other .DLL.

You have finished resolving conflicts. On the Projects tab, the check box next to the 
Resolve conflicts task is marked to indicate that the task is complete.

If you don’t have the Quality Assurance module, all the tasks in the Package Testing 
phase of the Repackaging for Windows Installer process are complete. If you have the 
Quality Assurance module, the Package Testing phase contains three additional tasks: 
Prepare package for deployment, Deploy instrumented package, and Analyze Results. 
This tutorial skips these tasks because they require integration with other computers.

Next, you make the package available for distribution to end users.

Make the Package Available
In this procedure, you update the status of the QuickFacts package to Available, which is 
the first step in the Release Management phase. The Make Package Available task runs 
Software Manager silently, which updates the status of the package and copies the 
package to the Available Packages subdirectory in the share point directory.

The Available Packages directory provides a centralized location for storing all of your 
packages that are complete and available for deployment, and keeping them separate 
from packages that are still in development.

Before you follow this procedure, you must have resolved conflicts.

See Resolve Conflicts with ConflictManager on page 71.

To make the package available

1. Make sure you are in Wise Package Studio with the Projects tab selected and 
QuickFacts selected in the Active Project drop-down list.

2. Click the Run link next to the Make Package Available task.

A dialog box appears briefly. The package status is updated to Available, and the 
package is copied to the Available Packages directory in the share point directory 
and marked as Read-only.

You have finished making the package available for distribution to end users. On the 
Projects tab, the check box next to the Make package available task is marked to 
indicate that the task is complete. Next, you will distribute the package to end users.
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Distribute the Package
In this procedure, you distribute the QuickFacts package to a location that can be 
accessed by end users. Normally, this would be a shared network drive or a distribution 
system. In this tutorial, you distribute it to your local drive. The Distribute package task 
runs Package Distribution.

After the package is distributed to end users, the Repackage for Windows Installer 
process is complete.

Before you follow this procedure, you must have made the package available.

See Make the Package Available on page 73.

To distribute the package

1. Make sure you are in Wise Package Studio with the Projects tab selected and 
QuickFacts selected in the Active Project drop-down list.

2. Click the Run link next to the Distribute Package task. Dialog boxes appear briefly 
and the package is recompiled.

The Distribution Method page of the Package Distribution tool appears. Options are 
available based on the type of package and the distribution systems available on the 
computer.

3. In the Other Distribution Options section, mark the Network and Installation 
options and click Next.

The Network Directory page appears.

4. In Network Directory, specify a directory in which to save the installation. 
Typically, this would be a shared network drive available to users. In this tutorial, 
specify a directory on your local drive.

5. To save the installation with a name other than its current name, enter the new 
name in Destination File Name.

6. Click Finish.

The package is distributed to the directory you specified.

On the Projects tab, the check box next to the Distribute Package task is marked to 
indicate that the task is complete.

You have completed the application repackaging process from capturing an application 
to distributing a package to end users. By following this process, you have ensured that 
your application is ready for deployment, installation, use, and maintenance within the 
context of the infrastructure of your organization.

(Optional.) If you are working in your company’s production database, you should 
remove the test applications Sample Conflict and QuickFacts from the database.

See Remove Tutorial Packages from Software Manager.

Remove Tutorial Packages from Software Manager
To ensure that your Software Manager database contains only production packages, 
remove the QuickFacts and Sample Conflict packages.
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To remove tutorial packages from Software Manager

1. In Wise Package Studio, click the Tools tab. At the top of the Tools tab, double-click 
Software Manager.

Software Manager opens.

2. Select Packages menu > Delete.

The Delete Package dialog box appears.

3. Select both the Sample Conflict and QuickFacts packages. 

4. To delete the package’s source files from the share point directory, mark the check 
box at the bottom of the dialog box.

5. Click OK.

The Sample Conflict and QuickFacts packages are deleted from the database.

6. Close Software Manager and Wise Package Studio.

You have completed this tutorial.
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